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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

• Thorough knowledge of navigating within Oracle Applications

• Working experience with at least one Oracle Applications module

Prerequisites

• R11i Navigate Oracle Applications

How This Course Is Organized

R11i System Administration is an instructor-led course featuring lecture and
hands-on exercises.  Online demonstrations and written practice sessions reinforce
the concepts and skills introduced.
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• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.
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Convention Element Example
Arrow Menu paths Select File—> Save.
Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.
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Notations :

(N) = Navigator

(M) = Menu

(T) = Tab

(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.
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To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.

3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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Course ObjectivesCourse Objectives

After completing this course, you should be able
to do the following:
• Manage security by granting users access and

defining application privileges
• Manage concurrent programs and reports by

using and controlling request options
• Administer concurrent managers to

balance workloads
• Define and manage printers

After completing this course, you should be able
to do the following:
• Manage security by granting users access and

defining application privileges
• Manage concurrent programs and reports by

using and controlling request options
• Administer concurrent managers to

balance workloads
• Define and manage printers

Introduction to Course Topics
This course discusses how to perform administrative tasks in an Oracle
Applications systems environment. You will learn to manage security by
granting users access and defining their application privileges, to administer
concurrent managers, to set profile options, and to register a custom application.
You will also learn to audit users and system processing, manage printers,
administer folders, and perform other applications DBA duties.
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After completing this course, you should be able
to do the following:
• Define system and personal profile settings
• Audit and monitor system processing
• Administer and manage folders
• Register a custom application
• Perform applications DBA duties

After completing this course, you should be able
to do the following:
• Define system and personal profile settings
• Audit and monitor system processing
• Administer and manage folders
• Register a custom application
• Perform applications DBA duties
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Block Diagram

Oracle Financial
Applications

Oracle Government
Financial

Applications
Oracle

Manufacturing
Applications

Oracle Human
Resources

Applications
Custom Extensions

to
Oracle Applications

Applications
Security

Concurrent
Processing
Workload

User
Preferences

Document
Sequences

What forms display
on my screen?

What reports and
programs can I run?

How is my online
performance versus
program and report

performance?
What are my
application

default settings?
Can I account for every

transaction, even
transactions that fail?

OracleOracle
ApplicationsApplications

SystemSystem
AdministratorAdministrator

UserUser
CommunityCommunity

Importance of This Course
System administrators are responsible to a user community that requires that
Oracle Applications be configured appropriately for application end users.
Typical demands of an applications user community are:

• Matching job descriptions to applications functionality
• Knowing the status of submitted (concurrent) reports and programs
• Choosing printers and defining print styles and printer drivers
• Changing an application’s default behavior
• Using document sequences to track documents generated by forms

transactions
• Creating customized menu prompts and descriptions

This course discusses how to meet these ongoing and changing needs in your
user community. You will learn how to adapt the applications usage for your
users over time.
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Peripheral
Registration

and Definitions

Can I use the
new printer down

the hall?

PeripheralPeripheral
Equipment and ToolsEquipment and Tools

SystemSystem
AdministratorAdministrator

UserUser
CommunityCommunity

Printer
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System Administration FunctionsSystem Administration Functions
ApplicationsApplications

sign-onsign-on
Forms andForms and
functionsfunctions

Programs Programs 
andand
reportsreportsDefineDefine

applications privilegesapplications privileges

ProgramsPrograms
andand
reportsreports

Save outputSave output
as OS fileas OS file

OnlineOnlineBalance online andBalance online and
concurrent processingconcurrent processing

DefaultDefault
printerprinter

Set applicationSet application
defaults ordefaults or
user profilesuser profiles

System Administration Functions
You can increase Oracle Applications benefits to your users by configuring
them to meet the needs of your company’s organizational structure, equipment,
and applications usage.
Database Administrator Versus System Administrator
A database management system can be seen as having two sides to it—a front
end that the user sees and works with and a back end where the actual work or
data manipulation is performed.
This natural division between user applications and their underlying data
structures lends itself to two job categories—database administrator and system
administrator.
An Oracle Applications system administrator manages the user interface or
applications side of the database management system.
An Oracle database administrator (DBA) manages the data that the various
applications enter, update, and use for company business.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Define an application user and assign

responsibilities
• Use and create responsibilities. Customize

application privileges for individual users or
categories of users

• Restrict access to menu items and functions by
responsibility

• Define custom menus

After completing this lesson, you should be able to
do the following:
• Define an application user and assign

responsibilities
• Use and create responsibilities. Customize

application privileges for individual users or
categories of users

• Restrict access to menu items and functions by
responsibility

• Define custom menus

Lesson Aim
One of the most important functions of a system administrator is to manage security for
the Oracle Applications environment. In Oracle Applications security is implemented
by creating user signons and relating them to a responsibility. The responsibility
specifies the actual access authorizations. This lesson shows you how to define both
user signons and responsibilities.
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Managing Application Security:
Overview

WindowsWindows

ReportsReportsUser

OracleOracle

ApplicationApplication

Responsibility

Managing Application Security: Overview
In an Oracle Application, the system administrator manages security by creating
user signons and assigning them to one or more responsibilities. Users then
have access to all the functionality associated with that responsibility.
User Security
You authorize a user to sign on to Oracle Applications by defining an
application user. You then assign one or more responsibilities to the new user.
Responsibility Security
A responsibility is a collection of authorizations that allow access to:

• A specific application or applications
• A set of books
• A restricted list of windows, functions, and reports

Each user has one or more responsibilities, and several users can share the same
responsibility.
A system administrator can assign users any of the standard responsibilities
provided with Oracle Applications or create new custom responsibilities as
needed.
Self-Service Applications Security
Oracle Self-Service Web Applications use columns, rows, and values in
database tables to define what information users can access. Table columns
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represent “attributes” that can be assigned to a responsibility. These attributes
are defined in the Web Application Dictionary.
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Using ResponsibilitiesUsing Responsibilities

Define
or modify

data group

Define
or modify

menu

Define 
or modify

responsibility

Exclude
functions

and menus

Define
application

user

Using PredefinedUsing Predefined
ResponsibilityResponsibility

Using Custom ResponsibilityUsing Custom Responsibility
Define

or modify 
request group

Define
application

user

Creating a New Responsibility
Generally you relate new application users to existing predefined
responsibilities. However, you can customize an existing responsibility or create
new responsibilities to accommodate the needs of different users or different
categories of users. When creating a new responsibility, it is generally easier to
modify an existing responsibility in one of two ways:
Extend Privileges That a Responsibility Owns
When users require additional reporting and summary information, you can:

• Use request groups to add additional program or report privileges to a
responsibility

• Use menus to add windows and tasks to a responsibility
Restrict Privileges That a Responsibility Owns
Sometimes it is easier to remove authorizations from an existing responsibility.
To do this you can:

• Use exclusions against a responsibility to limit menu and function access
privileges to those required for job duties

• Use request groups to limit program or report privileges for a
responsibility that requires only data entry privileges

After you have defined a new responsibility, you can associate it with an
application user.
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Defining a New Application UserDefining a New Application User

Assign one or more 
responsibilities

Enter user
name and password

Require password change
Limit access attempts

Enter user’s 
start and end dates

1

2

3

4

Steps 1, 3, and 4 are requiredSteps 1, 3, and 4 are required

Defining a New User
(N) Security > User > Define
Define an authorized user of Oracle Applications by specifying a username and
password.  Grant application privileges by assigning one or more
responsibilities to the user.
For a complete explanation of the fields on the Users Form see:
(Help) Applied Technology > Oracle Applications System Administration >
Overview of Oracle Applications Security > Users Window
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Responsibility ComponentsResponsibility Components

Request security
group

Data group

Menu

Exclusions

Components of a Responsibility
A responsibility has two required components and two optional components.
Required Components

• Data group: A data group specifies the Oracle Application database
accounts to which a responsibility’s forms and concurrent programs
connect.

• Menu: A menu specifies the forms that a responsibility can display and the
functions it can access.

Optional Components
• Request security group: A request group lists the concurrent programs that

a responsibility can run. When a request group is assigned to a
responsibility, it is referred to as a request security group.

• Exclusions: Exclusions modify a responsibility’s access to the forms and
functions specified by a menu.
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Defining an ApplicationDefining an Application

Application NameApplication Name Application
Object
Library

Application Short NameApplication Short Name

Application BasepathApplication Basepath

Application DescriptionApplication Description

Applications Window : (N) Application > Register
For a complete explanation of the fields in this form see:
(Help) Applied Technology > Oracle Applications System Administration >
Applications DBA > Applications Window
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Data GroupsData Groups

A data group is a collection of pairings of 
an application with an Oracle ID.

Can appear
only once

Can appear
multiple times, 
but only once
with each
application

GL
AP1
AR1

Oracle ID-A
Oracle ID-A
Oracle ID-A

Data Group

Responsibility XYZ

CUS Oracle ID-A

What Is a Data Group?
A data group is a collection of pairings of an application with an Oracle ID.
Data groups automatically support concurrent processing and cross-application
reporting. They guarantee that an application connects to a unique application
database account.
Note: The installation process automatically defines data groups for Oracle
Applications, so you only need to define additional data groups based on your
specific requirements.
Application-Oracle ID Pairs

• An application can be listed only once in a data group.
• An Oracle ID can be paired with more than one application.
• A custom application registered with Oracle Applications can be included

in a data group.
Data Groups and Application Object Library
Application Object Library owns the database tables referred to during
concurrent processing and the standard submission of reports by any Oracle
Application. Therefore all applications need access to the Application Object
Library tables. When you are defining a data group, the application Application
Object Library is automatically included. The Application Object Library’s
Oracle ID cannot be updated or deleted.
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Registering an Oracle IDRegistering an Oracle ID

You can provide access to an Oracle account (Oracle
ID) by working with an Oracle database administrator.
You can provide access to an Oracle account (Oracle
ID) by working with an Oracle database administrator.

Ask the database
administrator to create a
new Oracle username and
password that connects to
an existing Oracle account
(Oracle ID).

Ask the database
administrator to create a
new Oracle username and
password that connects to
an existing Oracle account
(Oracle ID).

Registering an Oracle ID
(N) Security > ORACLE > Register

• Only database administrators can create Oracle accounts.
• The install group designates which data group the application is associated

with. For applications that span all data groups, the install group is 0.
Install groups numbered 1 or greater are associated with one specific data
group. Your database administrator can supply the correct install group
number.
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Defining a Data GroupDefining a Data Group

Define Oracle ID
(DBA task)

Enter name for new data group

Model new data group from
existing data group

Associate application with 
appropriate Oracle ID

1

2

3

4

Defining Data Groups
By defining a data group, you can determine which Oracle account (Oracle ID)
an application’s windows, reports, or concurrent programs connect to. Use data
groups to grant application database account privileges to a responsibility and
the requests that it submits
Data Groups Serve Two Purposes

• Identify the Oracle ID to which forms connect when users select the
responsibility. Choose one application-Oracle ID pair from the data group
to associate with your responsibility’s windows.

• Concurrent managers use a data group to match the application that owns
a report or concurrent program with a unique Oracle ID.

Additionally, you can incorporate custom applications by granting application
database access to custom applications that you develop. Alternatively, use
custom applications to name customized versions of concurrent programs,
responsibilities, and concurrent managers to protect your customizations during
an upgrade.
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GL
AP1
AR1

Oracle ID-A
Oracle ID-A
Oracle ID-A

Data Group

Responsibility XYZ

CUS Oracle ID-A

Relating Data Groups
to Forms and Programs
Relating Data Groups

to Forms and Programs

SERVER

FormForm

ProgramProgram

database

table

Relating Data Groups to Forms and Programs
You can control the relationship among applications, forms, and concurrent
programs by defining a data group.
Applications, Forms, and Programs

• A window connects to the application database account designated by the
responsibility associated with the application.

• A data group determines the pairing of an application with a unique
application database account or Oracle ID.

• A program connects to the application database account associated with
the application that owns the program.

Application-Oracle ID Pairs
• An Oracle ID is a username and password that allows access to application

tables in an Oracle database.
• A data group lists the Oracle ID assigned to each Oracle application.
• A custom application registered with Oracle Applications can be included

in a data group and paired with an Oracle ID.
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Defining a Data GroupDefining a Data Group

By defining a data group you can:
• Associate an Oracle ID (database account) with an

application
• Maintain a list of Oracle Applications and their

Oracle IDs

By defining a data group you can:
• Associate an Oracle ID (database account) with an

application
• Maintain a list of Oracle Applications and their

Oracle IDs

Data Groups Form:
(N) Security > ORACLE > DataGroup
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Managing Function SecurityManaging Function Security

Menu Level 1 Menu Level 1 

Menu Level 2 Menu Level 2 

Menu Level 2 Menu Level 2 

FunctionFunction

FunctionFunction

FunctionFunction
FunctionFunction

FunctionFunction

FunctionFunction

SubfunctionSubfunction
SubfunctionSubfunction

SubfunctionSubfunction

Menu Level 3Menu Level 3

Menu Level 2Menu Level 2

Function: A set ofFunction: A set of
executable code executable code 
available as a menu available as a menu 
optionoption

Subfunction: A subset Subfunction: A subset 
of a form’s functionalityof a form’s functionality

Function Security
You can manage security by controlling access to individual functions through
menu definitions.
About Functions

• A function is a set of code in Oracle Applications that is executed only if
the name of the function is present in a list maintained within a
responsibility.

• There are two types of functions: a form function and a nonform function
or subfunction. A subfunction represents a securable subset of a form’s
functionality.

Web Regions
The fields in the Web regions are required only if your function will be accessed
from Oracle Self-Service Web Applications.
Adding Functions to or Removing Functions from a Responsibility

• Maintain menu structures while eliminating specific functionality.
• Exclude individual functions from a responsibility.

Adding or Removing Menus of Functions
• Use menus to group functions together.
• Exclude groups of functions by excluding a menu from a responsibility.
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 Using Navigator Using Navigator

Menu Level 1 Menu Level 1 

Menu Level 2 Menu Level 2 

Menu Level 2 Menu Level 2 

FunctionFunction
FunctionFunction

FunctionFunction
FunctionFunction

FunctionFunction

FunctionFunction

What is built into the menu?What is built into the menu?

What is seen in Navigator?What is seen in Navigator?

Menu Level 1 Menu Level 1 

Menu Level 2 Menu Level 2 

Menu Level 2 Menu Level 2 

FunctionFunction

FunctionFunction

FunctionFunction
FunctionFunction

FunctionFunction

FunctionFunction

SubfunctionSubfunction
SubfunctionSubfunction

SubfunctionSubfunction

Menu Level 3Menu Level 3

Menu Level 2Menu Level 2

Navigator Menu Displays
Navigator displays only the menu items needed for navigation. Because you
cannot choose subfunctions from a menu, they are not displayed. Submenus
consisting only of subfunctions are also not displayed.
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Excluding Functions and MenusExcluding Functions and Menus

Menu Level 1 Menu Level 1 

Menu Level 2 Menu Level 2 

Menu Level 2 Menu Level 2 

Function-CFunction-C

Function-EFunction-E

Function-GFunction-G
Function-FFunction-F

Function-AFunction-A

Function-BFunction-B

Function-AFunction-A
Function-DFunction-D

Function-DFunction-D

Menu Level 3Menu Level 3

Menu Level 2Menu Level 2

Function-HFunction-H

Excluding a function affects the Excluding a function affects the 
function regardless of level.function regardless of level.

Excluding a menu excludes all Excluding a menu excludes all 
its child functions.its child functions.

Exclusion of Functions and Menus
Use exclusion rules to customize a responsibility. You can exclude functions at
any level.

• When you exclude a menu item from a responsibility, all menus and
functions that are nested in that menu are also excluded.

• When you exclude a function from a responsibility, all occurrences of that
function throughout the menu structure of a responsibility are excluded.
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Assign to the responsibility

Defining a New Menu StructureDefining a New Menu Structure

Identify menu needs

Print function security report for 
similar existing menus

Start with a blank menu form

Print a function security report set to 
document the new menu

Build the menu from bottom to top

Plan the menu structure

New Menu Structure
Use the Menus form to define menus pointing to functions that you want to
make available to a new responsibility.
Make New Responsibilities, Not New Menus
If possible, apply exclusion rules to existing menus to customize a responsibility
rather than constructing an entirely new menu structure.
Determine the Application Functionality Required

• Different jobs require access to different function groups.
• Identify predefined menus, forms, and form subfunctions to use as entries

when defining a new menu.
Plan Your Menu Structure

• Start with a blank Menus form (blank screen). Menus cannot be copied. A
menu saved under a different name overwrites the original menu (there is
no Save As feature).

• Start with the lowest-level menus. A menu must be defined before it can
be selected as an entry on another menu.

• Assign menus and functions to higher-level menus.
• Document your menu structure by printing the Function Security Menu

Report.
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• Assign the menu structure to a new responsibility by using the
responsibilities form.

• Create a new responsibility.
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Identifying Existing Menu
Structures

Identifying Existing Menu
Structures

Function Security Report SetFunction Security Report Set

Function Security Menu ReportFunction Security Menu Report

Function Security Navigator ReportFunction Security Navigator Report

Function Security Function ReportFunction Security Function Report

Designing a New Menu Structure
Before designing a new menu structure, identify any possible existing menu
structures that can be modified or modeled from, and document custom menus
by using reports in the Function Security Report Set.
Function Security Menu Report

• Lists the full menu name of the responsibility
• Indicates any excluded menu items, with the rules that exclude them

Function Security Navigator Report
• Lists the menu as it appears in the Navigator for the responsibility

specified
• Does not include items excluded by function security rules

Function Security Function Report
• Lists the functions accessible by the responsibility specified
• Does not include items excluded by function security rules



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing Application Security
Chapter 2 - Page 21

Menu Guidelines

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Menu GuidelinesMenu Guidelines

• Design prompts with unique first letters.
• Sequence the prompts with the most frequently

used functions first.
• Entries cannot be copied from one menu definition

to another.
• Use acronyms only when an industry term or

company word is so capitalized—for example, WIP
or COGS.

• Use integers in numbering.

• Design prompts with unique first letters.
• Sequence the prompts with the most frequently

used functions first.
• Entries cannot be copied from one menu definition

to another.
• Use acronyms only when an industry term or

company word is so capitalized—for example, WIP
or COGS.

• Use integers in numbering.
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Modifying an Existing Menu
Definition

Modifying an Existing Menu
Definition

• Menus are called by their user menu name.
• Any change to a user menu name takes effect

immediately.
• Any existing menus that call the modified menu

use the new name.
• The previous name no longer appears.
• Any menu entry modifications take effect

immediately.

• Menus are called by their user menu name.
• Any change to a user menu name takes effect

immediately.
• Any existing menus that call the modified menu

use the new name.
• The previous name no longer appears.
• Any menu entry modifications take effect

immediately.

Modifying a Menu
You can modify predefined menus to suit specific job functions.
Overwrite a User Menu Name
When you change a menu’s user menu name, the menu entries are not affected.
The menu’s definition still exists, but under a new name. Other menus that call
the menu by its old user menu name now call the same menu by its new
(revised) user menu name.
The old user menu name is no longer valid. When you are defining menus, or if
you are selecting main menus when defining a responsibility, the previously
named menu is no longer displayed in any list of values.
Modify a Menu Entry
When you are modifying a predefined menu, all other menus that call that menu
display the menu’s modifications. For example, if you modify
GL_SUPERUSER4.0 by adding another prompt that calls a form, all menus that
call GL_SUPERUSER4.0 display the additional prompt when
GL_SUPERUSER4.0 is displayed.
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Creating a MenuCreating a Menu

Use the following guidelines as you build your menu:
• Build your menus from the bottom.  A menu

structure must already exist for a menu at a higher
level to reference it.

• Give your menu both an internal and user name.
• The sequence number specifies the order in which

your options are displayed on the menu.
• The Navigator prompt is the prompt that the user

sees to invoke this function or menu.
• Each entry on the menu definition form refers to

either a function or another submenu.

Use the following guidelines as you build your menu:
• Build your menus from the bottom.  A menu

structure must already exist for a menu at a higher
level to reference it.

• Give your menu both an internal and user name.
• The sequence number specifies the order in which

your options are displayed on the menu.
• The Navigator prompt is the prompt that the user

sees to invoke this function or menu.
• Each entry on the menu definition form refers to

either a function or another submenu.

Use the Menus window to create a menu:
(N) Application > Menu
For a complete explanation of the fields on this form see:
(Help) Applied Technology > Oracle Applications System Administration >
Function Security > Menus Window
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Using the Menu ViewerUsing the Menu Viewer

• The Menu Viewer is a read-only window that
provides a hierarchical view of the submenus and
functions of a menu, and also lists properties of
the menus and functions.

• When you create a new menu, your changes must
be committed to the database before you can see
them in the Menu Viewer.

• The Menu Viewer is a read-only window that
provides a hierarchical view of the submenus and
functions of a menu, and also lists properties of
the menus and functions.

• When you create a new menu, your changes must
be committed to the database before you can see
them in the Menu Viewer.

Viewing the Menu Tree
(N) Application > Menu > (B) View Tree...

• To view the menu tree, click on the plus (+) sign next to the menu name.
You will see a hierarchical tree with a number of nodes. Each node
represents a function or submenu of your main menu.

• The menu tree displays the user menu name for the main menu, and
displays the prompts from the Menus form for submenus and functions. If
no prompt has been specified, then no label will appear for the node.

Printing the Menu Tree
To print a menu tree, choose Print from the File menu.
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Viewing Node PropertiesViewing Node Properties

Use one of the following methods to view a node’s
sequence number, prompt, and description:
• Highlight the node in the menu tree to view the

properties in the properties pane.
• Create a separate Properties window by clicking

the “push pin” button at the top of the Properties
pane.

• Select Properties from the View menu.

Use one of the following methods to view a node’s
sequence number, prompt, and description:
• Highlight the node in the menu tree to view the

properties in the properties pane.
• Create a separate Properties window by clicking

the “push pin” button at the top of the Properties
pane.

• Select Properties from the View menu.
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Defining a New ResponsibilityDefining a New Responsibility

Enter application and
responsibility name

Enter start and end dates

Select data group

Select menu

1

2

3

4

Select request group

Enter menu or function exclusions

5

6

Defining a New Responsibility
• Assemble the components of application privileges to create a

responsibility.
• Define the responsibility by assembling a menu, report security group, and

data group and defining any function security (any menu or function
exclusions).
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Responsibility Creation ProcessResponsibility Creation Process

Data groups

Security
    ORACLE
        DataGroup

Menus

Application
    Menu

Responsibilities

Security
    Responsibility
        DefineRequest groups

Security
    Responsibility
        Requests

Users

Security
    User    
        Define
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Defining a New ResponsibilityDefining a New Responsibility

You must assign the following to your new
responsibility:
• A data group to supply the form, report, and

program connect privileges
• A menu to supply access to forms within an

application
• Any function or menu exclusions to control

access to the functionality of the application
• A report security group to control access to

reports and concurrent programs

You must assign the following to your new
responsibility:
• A data group to supply the form, report, and

program connect privileges
• A menu to supply access to forms within an

application
• Any function or menu exclusions to control

access to the functionality of the application
• A report security group to control access to

reports and concurrent programs

Defining a Responsibility
(N) Security > Responsibility > Define
A responsibility determines if the user accesses Oracle Applications or Oracle
Self-Service Web Applications, which application functions a user can use,
which reports and concurrent programs the user can run, and which data those
reports and concurrent programs can access.
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SummarySummary

You should now be able to do the following:
• Control access to applications by defining

signons
• Control access to database accounts by defining

data groups
• Control access to functionality by defining menus
• Combine data group and menu definitions into

custom responsibilities

You should now be able to do the following:
• Control access to applications by defining

signons
• Control access to database accounts by defining

data groups
• Control access to functionality by defining menus
• Combine data group and menu definitions into

custom responsibilities

Lesson Summary
One of the most important functions of the system administrator is controlling
applications security. The system administrator specifies which users have
access to which functions. User signons provide the user access to an
application. Responsibilities control that user’s access to various functions of
the application. Online access is controlled through the use of menus and menu
exclusions. Report and concurrent program access is controlled through the use
of request groups.
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Creating New User Signons Practice
Instructions

• In this practice you will create three new user
signons and associate each user with several
responsibilities.

• After you have defined the new user signons, sign
off and back on using the new signons.  Check
that all the responsibilities that you defined are
available.

• In this practice you will create three new user
signons and associate each user with several
responsibilities.

• After you have defined the new user signons, sign
off and back on using the new signons.  Check
that all the responsibilities that you defined are
available.

Instructions
In this practice you will create three new user signons and associate each user
with several responsibilities. Use the values below to define these new users.
After you have defined the new user signons, sign off and back on using the
new signon. Check that all the responsibilities that you defined are available.
User #1

User Name: Your System Administrator User Name_______________
Password: WELCOME
Description: System Administrator
Password Expiration: 30 days
Effective Dates: today - 2 months from today
Responsibility: System Administrator

User #2
User Name: Your GL Controller User Name ____________________
Password: WELCOME
Description: Controller
Password Expiration: 90 days
Effective Dates: none
Responsibility: General Ledger, Vision Operations (USA)
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Payables, Vision Operations (USA)
Receivables Manager
Purchasing, Vision Operations (USA)

User #3
User Name: Your Accounts Payable Clerk User Name ____________
Password: WELCOME
Description: Accounts Payable Clerk
Password Expiration: 30 accesses
Effective Dates: none
Responsibility: Payables Vision ADB (USA)

Practice Solutions
Enter User #1

1. Navigate to (N) Security > User > Define.
2. Type in the appropriate information for User #1 as described in the

instructions.
3. Click Save to save your work.

Enter User #2
4. Navigate to (N) Security > User > Define.
5. Type in the appropriate information for User #2 as described in the

instructions.
6. Click Save to save your work.

Enter User #3
7. Navigate to (N) Security > User > Define.
8. Type in the appropriate information for User #3 as described in the

instructions.
9. Click Save to save your work.

Review Your New Users
10. Select (M) File > Log on as a Different User... to check each user account

that you set up. You will have to change the passwords, so be sure to write
down the new passwords.
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Working with Custom Applications
Practice Instructions

• In this practice you will register a custom
application, create a new data group, and then
associate your new application with that data
group.

• Use the information on the following slides to
register your new custom application with Oracle
Applications.  Use “XX” for your own initials to
keep your data unique to the database.

• In this practice you will register a custom
application, create a new data group, and then
associate your new application with that data
group.

• Use the information on the following slides to
register your new custom application with Oracle
Applications.  Use “XX” for your own initials to
keep your data unique to the database.

Instructions
For Your Custom Application

Application: Your Custom Application Name
___________________________

Short Name: Use XX plus two or three initials of your custom application
name. Write it here ___________________

Basepath: FND_TOP
Note: For class purposes, we are using a predefined basepath; if you were
truly defining a custom application for your organization, this would be a
unique basepath.

Description: My Custom Application
For Your Data Group

Name: Your Company Name Data Group
_______________________________

Application: Your Custom Application Name
Oracle ID: APPS

Use the “Copy Applications From” button to copy the Applications from
the Oracle provided data group to your custom data group. Then, add a
record to the new data group you create and add the custom application
that you just registered.
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Practice Solutions
Register Your Custom Application

1. Navigate to (N) Application > Register.
2. Enter the data from the instructions into the appropriate fields on the

window.
3. Click Save to save your work.

Create Your Data Group
4. Navigate to (N) Security > ORACLE > DataGroup.
5. Enter your data group name and description.
6. Click the Copy Applications From... button.
7. Select “Standard” to copy the Applications from the Oracle-provided data

group to your custom data group.
8. Ensure that your cursor is located within the applications block and click

the New toolbar icon or choose New from the File menu to add a row for
your custom application.

9. Choose your custom application name from the list of values for the
Application field.

10. Choose APPS from the list of values for the Oracle ID field.
11. Enter your description.
12. Click Save to save your work.
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Defining Responsibilities Practice
Instructions

Defining Responsibilities Practice
Instructions

• In this practice you will create and test a new
responsibility.  This responsibility will be used by
your new assistant system administrator.

• You only want to allow your assistant to do the
following:
– Define Request Security Groups
– Submit Requests
– View Completed Requests
– Define Standard Request Sets

• In this practice you will create and test a new
responsibility.  This responsibility will be used by
your new assistant system administrator.

• You only want to allow your assistant to do the
following:
– Define Request Security Groups
– Submit Requests
– View Completed Requests
– Define Standard Request Sets

Instructions
Use the information in the chart below to define your responsibility.
Name: Your Company Name Temp Sys Admin
__________________________
Application: Your Company Name Custom Application
Responsibility Key: Your Company Name Initials
________________________
Description: Temp Sys Admin
Data Group Name: Your Company Name Data Group
Data Group Application: Your Company Name Custom Application
Menu: Navigator Menu - System Administrator
In order to test this new responsibility, create a new user signon for your
assistant system administrator and assign your newly created responsibility to
this user signon. Use the information in the chart below to create a new user
signon.
User Name: Your Temp Sys Admin User Name
____________________________
Password: WELCOME
Description: Temp System Administrator
Password Expiration: 30 days
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Responsibility: Your Company Name Temp Sys Admin
Once you have defined it, sign off and back on using the new signon. Check
that all the specialized responsibilities and exclusions that you intended apply to
this new user.

Practice Solutions
Create Your New Responsibility

1. Navigate to (N) Security > Responsibility > Define.
2. Enter the data from the instructions in the appropriate fields in the

window.
3. Choose Menu in the Type field, use the LOV in the Name field, and

exclude all of the items listed, except the following:
Standard Report Submission and View Report (privileged)
Program Menu - System Administrator
Concurrent Menu - System Administrator

4. Click Save to save this responsibility.
Create a New User Signon

5. Navigate to (N) Security > User > Define
6. Enter the data from the instructions in the appropriate fields in the

window.
7. Click Save to save your work
8. Test the New Signon and Responsibility
9. Select (M) File > Log on as a Different User...
10. Log on as your new user.
11. Note that the menu items that you excluded are not there.
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 Defining Custom Menus Practice
Instructions

 Defining Custom Menus Practice
Instructions

• Your company has hired a system auditor to
monitor various system administration tasks.  You
need to give him access to the appropriate menu
options and reports.

• In this practice you will use specifications to plan
and create a customized menu.

• You will then associate the new menu with a new
responsibility, create a user of the new
responsibility, and use the new user signon to test
the menu.

• Your company has hired a system auditor to
monitor various system administration tasks.  You
need to give him access to the appropriate menu
options and reports.

• In this practice you will use specifications to plan
and create a customized menu.

• You will then associate the new menu with a new
responsibility, create a user of the new
responsibility, and use the new user signon to test
the menu.

Instructions
Level Three Menu
Menu Name: Your Company Name Level Three Menu
______________________
User Menu Name: Your Company Name Level Three Menu
Description: Custom Menu

Sequence 1 2
Navigator Prompt Define Assign
Submenu n/a n/a
Function Flexfield Security Rules Assign Flexfield 

Security Rule
Description n/a n/a

Level Two Menu
Menu Name: Your Company Name Level Two Menu
______________________
User Menu Name: Your Company Name Level Two Menu
Description: Custom Menu Level Two

Sequence 1 2
Navigator Prompt Define Request
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Submenu n/a n/a
Function Responsibilities Request Groups
Description n/a n/a

Sequence 3 4
Navigator Prompt Value Sets Terminal
Submenu “Co. Name” Level 3 Terminal Menu - 

Sys Admin GUI
Function n/a n/a
Description n/a n/a

Level One Menu
Menu Name: Your Company Name Level One Menu
______________________
User Menu Name: Your Company Name Level One Menu
Description: Custom Menu Level One

Sequence 1 2
Navigator Prompt User Responsibility

Submenu User Menu- “Co. Name” Level 2
Sys Admin GUI

Function n/a n/a
Description n/a n/a

Sequence 3 4
Navigator Prompt ORACLE GL Financials
Submenu ORACLE Menu- GL_SU_FINAN

Sys Admin GUI CIAL_GUI
Function n/a n/a
Description n/a n/a

Create the New Responsibility
Name: Your Company Name System Auditor ___________________________
Application: Your Company Name Custom Application
Responsibility Key: Your Company Name Initials
Description: System Auditor
Data Group Name: Your Company Name Data Group
Data Group Application: Your Company Name Custom Application
Menu: Your Company Name Level One Menu
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Assign the Responsibility to a New User
User Name: Your System Auditor User Name
_____________________________
Password: WELCOME
Description: System Auditor
Password Expiration: none
Responsibility: Your Company Name System Auditor
Test that the new user, responsibility, and newly created and assigned menu
work properly.

Practice Solutions
Create Your Custom Menus

1. Navigate to (N) Application > Menu.
2. Enter the data from the instructions in the appropriate fields in the

window.
3. Click Save to save your work.
4. Repeat steps 1-3 for the level-two and level-one menu definitions.
5. Click View Tree... to see your new menus in the Menu Viewer.

Assign Your Custom Menus to a New Responsibility
6. Navigate to (N) Security > Responsibility > Define.
7. Enter the data from the instructions in the appropriate fields in the

window.
8. Click Save to save your work.

Assign Your New Responsibility to a New User
9. Navigate to (N) Security > User > Define.
10. Enter the data from the instructions in the appropriate fields in the

window.
11. Click Save to save your work.

Test Your New User, Responsibility, and Menu
12. Select (M) File > Log on as a Different User...
13. Sign on as your System Auditor user name and note that the menu is the

custom menu that you just created.
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Managing Concurrent Programs  and Reports
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Managing Concurrent Programs
and Reports

Managing Concurrent Programs
and Reports

Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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ObjectivesObjectives

After completing this lesson, you should be able to
do the following:
• Use Standard Request Submission (SRS) to

submit requests
• Monitor the processing of a request
• Define a request group to control user access to

reports
• Customize the standard SRS processing of reports

by defining a request group with a code
• Set default parameter values and share values

among multiple reports by defining a request set

After completing this lesson, you should be able to
do the following:
• Use Standard Request Submission (SRS) to

submit requests
• Monitor the processing of a request
• Define a request group to control user access to

reports
• Customize the standard SRS processing of reports

by defining a request group with a code
• Set default parameter values and share values

among multiple reports by defining a request set

Lesson Aim
An important area of security involves controlling access to reports and other
concurrent programs. This level of security is provided by request group
definitions. This lesson shows how the system administrator creates and uses
these request groups.
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ObjectivesObjectives

After completing this lesson, you should be able to
do the following:
• Control the behavior and update of report

parameters by defining a request set
• Control user access to reports and programs by

specifying the ownership of a request set

After completing this lesson, you should be able to
do the following:
• Control the behavior and update of report

parameters by defining a request set
• Control user access to reports and programs by

specifying the ownership of a request set
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Concurrent Requests, Programs,
and Managers

Concurrent Requests, Programs,
and Managers

User submitsUser submits
request to run request to run 
programprogram abc abc

ConcurrentConcurrent
manager manager 

startsstarts
programprogram abc abc

Run program abc

Run program ...
Run program ...
Run program ...

Run program ...

Request Table

Concurrent
manager

Concurrent Requests, Programs, and Managers
Concurrent processing allows long-running, data-intensive programs to run
simultaneously with online operations.

• Oracle Applications programs can run concurrently with each other as
well as with other programs; they are referred to as concurrent programs.

• Requests to run Oracle Applications programs—for example, to run an
Oracle General Ledger report—are concurrent requests. Each concurrent
request inserts a row into a database table maintained by the Oracle
Application Object Library.

• Concurrent managers read requests from the requests table and start
concurrent programs.
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Business Needs for Concurrent
Processing

Business Needs for Concurrent
Processing

Concurrent processing helps you satisfy the
following business needs:
• Continue working at your computer while running

data-dependent reports and programs.
• Fully use the capacity of your hardware by

executing many application tasks at once.

Concurrent processing helps you satisfy the
following business needs:
• Continue working at your computer while running

data-dependent reports and programs.
• Fully use the capacity of your hardware by

executing many application tasks at once.
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Business Needs for Standard Request
Submission

Business Needs for Standard Request
Submission

Standard Request Submission enables you to:
• Use a standard interface to run your programs

and reports
• Control access to different reports and programs
• View report output online
• Automatically run programs, reports, or request

sets at specific time intervals
• View a log file that summarizes the completion

information about all the reports and programs in
a request set

Standard Request Submission enables you to:
• Use a standard interface to run your programs

and reports
• Control access to different reports and programs
• View report output online
• Automatically run programs, reports, or request

sets at specific time intervals
• View a log file that summarizes the completion

information about all the reports and programs in
a request set
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• Concurrent Request
• Concurrent Manager
• Request Set
• Stage

• Concurrent Request
• Concurrent Manager
• Request Set
• Stage

Concurrent Processing Definitions
Concurrent Request
A concurrent request is a request that you submit to run a concurrent program
as a concurrent process. You issue a concurrent request when you submit a
report or program to run using Standard Request Submission (SRS) or when
you click an action button in a product-specific submission window.
Concurrent Manager
A concurrent manager is a component of concurrent processing that monitors
and runs requests without tying up your computer.
Request Set
A request set is a collection of reports or programs that you group together. You
submit the reports or programs in a request set all at once, using one transaction.
Stage
A stage is a component of a request set used to group requests within the set.
All requests in a stage are run in parallel, while the stages themselves are run
sequentially in the request set.
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• Parameter
• Concurrent Processing Options
• Online Request Review

• Parameter
• Concurrent Processing Options
• Online Request Review

Concurrent Processing Definitions (continued)
Parameter
In SRS, a parameter is a report variable whose value you can change each time
you run a report. For example, you might run an account balance report and
change the account number whenever you run the report. The account number is
the parameter for the report.
Concurrent Processing Options
You can control and change certain run options for each of your concurrent
requests. Not only can you control and change the number of copies to print,
which print style to use, and which printer to use, but you can also choose to
hold a request from being run, choose a specific date or time to start a request,
or choose to save the results of your concurrent request in a standard file format.
Online Request Review
You can review the output and log files from your concurrent requests online.
You can see the results of a concurrent request without the delay of printing out
the entire report or log file.
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Submit Request FlowSubmit Request Flow

Submit Request

Enter Information

Click Submit

Record Request ID

Enter Parameters

Define Submission 
Schedule

Completion Options

May be requiredMay be required

OptionalOptional

OptionalOptional

Using Standard Request Submission (SRS)
Using Standard Request Submission gives you control over how you can run
your requests and request sets.

• There are three elements involved in submitting a request: selecting the
request or request set to be submitted, defining a submission schedule, and
providing completion options.

• Defining a schedule can be as simple as submitting As Soon as Possible,
or it can involve using a more complex schedule that you define when you
first submit your request. This schedule can then be used for other requests
in the future.

• Completion options enable you to deliver notification to others using
Oracle Workflow, as well as specifying which printers and how many
copies of the output you want to produce for each request.

• You can submit as many requests as you like from the Submit Request
window. You can even submit a request more than once if you want to run
the same request with different parameter values.
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Submit a New RequestSubmit a New Request

1. Navigate to the Submit a New Request Window:
(N) Requests > Run

2. Check the option for Single Request or Request
Set.

3. Click OK.
4. Use the Copy a Prior Request button to use a

previously entered request submission
or

Select the name of the request that you want to
run from the list of values.

1. Navigate to the Submit a New Request Window:
(N) Requests > Run

2. Check the option for Single Request or Request
Set.

3. Click OK.
4. Use the Copy a Prior Request button to use a

previously entered request submission
or

Select the name of the request that you want to
run from the list of values.

The responsibility that you are using determines the request group and the
requests that will appear in the list of available requests.
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Using the Parameters WindowUsing the Parameters Window

• A Parameters window automatically appears if you
select a request that requires parameter values.

• The Prompts in the Parameters window are
specific to the request that you select.

• The parameters you enter are concatenated and
displayed in the Parameters field of the Submit
Requests window.

• A Parameters window automatically appears if you
select a request that requires parameter values.

• The Prompts in the Parameters window are
specific to the request that you select.

• The parameters you enter are concatenated and
displayed in the Parameters field of the Submit
Requests window.
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Defining a Submission ScheduleDefining a Submission Schedule

1. From the Submit Request window, click
Schedule…

2. In the Schedule window you can either Apply a
Saved Schedule or establish a schedule by
choosing one of the scheduling options.

3. To apply a saved schedule, click the button to
display the Predefined Schedules find window.

4. Find the schedule you want to apply and click OK.
5. A message describing the schedule or further

scheduling options for you to define will appear in
the window.

1. From the Submit Request window, click
Schedule…

2. In the Schedule window you can either Apply a
Saved Schedule or establish a schedule by
choosing one of the scheduling options.

3. To apply a saved schedule, click the button to
display the Predefined Schedules find window.

4. Find the schedule you want to apply and click OK.
5. A message describing the schedule or further

scheduling options for you to define will appear in
the window.

Submitting Requests
(N) Concurrent > Requests > Submit a New Request > (B) Schedule...
The Schedule Window
The scheduling window provides you with several scheduling options. You can
choose to reuse a schedule that you previously defined and saved, or define a
new schedule. You can define your schedule to run a request as soon as
possible, at a specific time, or repeatedly at specific intervals, or on specific
days of the week or month.
When saving your schedule you must provide a unique name. You can also
provide additional information in the Description field.
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Defining a Submission ScheduleDefining a Submission Schedule

6. To define your own schedule, choose one of the
Run the Job… options.

7. The option you choose determines the type of
calendar that appears for you to define your
schedule.

8. If you wish to save your schedule for future use,
click the “Save this schedule” check box.

9. The Save Schedule window appears.  Enter a name
and description for your schedule.

6. To define your own schedule, choose one of the
Run the Job… options.

7. The option you choose determines the type of
calendar that appears for you to define your
schedule.

8. If you wish to save your schedule for future use,
click the “Save this schedule” check box.

9. The Save Schedule window appears.  Enter a name
and description for your schedule.

Define Submission Schedule (continued)
(N) Concurrent > Requests > Submit a New Request > (B) Schedule...
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Defining Completion OptionsDefining Completion Options

1. Check the Save all Output Files check box to write
your request to a file.  If you want to view your
report online, you must enable this box.

2. Click the Options… button.
3. Specify additional people to notify using Oracle

Workflow, upon completion of this report.
4. Select a print style, a printer, and a number of

copies.
5. Click OK.
6. Click Submit Request to submit your request.

1. Check the Save all Output Files check box to write
your request to a file.  If you want to view your
report online, you must enable this box.

2. Click the Options… button.
3. Specify additional people to notify using Oracle

Workflow, upon completion of this report.
4. Select a print style, a printer, and a number of

copies.
5. Click OK.
6. Click Submit Request to submit your request.

Submitting Requests
(N) Concurrent > Requests > Submit a New Request >  (B) OK >  (B) Options...
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Request IDRequest ID

• Oracle Applications assigns a
request ID to each request
submission so that you can identify
your request.

• Use the request ID to query for your
request output in the Requests
window.

• Oracle Applications assigns a new
request ID to each resubmission of
a request and displays the request
ID of the previous request in the log
file.

• Oracle Applications assigns a
request ID to each request
submission so that you can identify
your request.

• Use the request ID to query for your
request output in the Requests
window.

• Oracle Applications assigns a new
request ID to each resubmission of
a request and displays the request
ID of the previous request in the log
file.

Request #

12345
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Reprinting a ReportReprinting a Report

1. Navigate to the Requests window:
(N) Requests > View

2. Query your request so that it is displayed as a
record in the Requests window.

3. Select your request.
4. From the Tools menu select Reprint...

1. Navigate to the Requests window:
(N) Requests > View

2. Query your request so that it is displayed as a
record in the Requests window.

3. Select your request.
4. From the Tools menu select Reprint...
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Use the Requests Window to View and
Change Requests

Use the Requests Window to View and
Change Requests

Use the Requests window to perform the following
functions:
• View all submitted concurrent requests
• Check the status of requests
• Change aspects of a request’s processing options
• Diagnose Errors
• Find the position of a request in the queues of

available concurrent managers

Use the Requests window to perform the following
functions:
• View all submitted concurrent requests
• Check the status of requests
• Change aspects of a request’s processing options
• Diagnose Errors
• Find the position of a request in the queues of

available concurrent managers
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How to Use the Requests WindowHow to Use the Requests Window

1. Navigate to the Find Requests window:
(N) Requests > View

2. Enter specific criteria in the Find Requests
window

or
Click Find to display all your submitted requests.

1. Navigate to the Find Requests window:
(N) Requests > View

2. Enter specific criteria in the Find Requests
window

or
Click Find to display all your submitted requests.
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Using the Requests WindowUsing the Requests Window

Use the various buttons to perform tasks related to
concurrent processing:
• Refresh Data - Requeries the lines in the request

table.
• Find Requests - Displays the Find Request

window to perform a search.
• Submit a New Request… - Displays the Submit a

New Request window.
• Hold Request - Puts a request on hold if the

request has not started running.
• Cancel Request - Cancels a request

Use the various buttons to perform tasks related to
concurrent processing:
• Refresh Data - Requeries the lines in the request

table.
• Find Requests - Displays the Find Request

window to perform a search.
• Submit a New Request… - Displays the Submit a

New Request window.
• Hold Request - Puts a request on hold if the

request has not started running.
• Cancel Request - Cancels a request
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Using the Requests WindowUsing the Requests Window

Use the various buttons to perform tasks related to
concurrent processing:
• View Details... - Displays the Request Detail

window.  If the request has not already run, you
can change selected fields.

• Diagnostics - Displays diagnostic information
about a request.

• View Output - Displays an online format of the
report.

• View Log… - Displays information about the
request such as arguments used and other
technical information.

Use the various buttons to perform tasks related to
concurrent processing:
• View Details... - Displays the Request Detail

window.  If the request has not already run, you
can change selected fields.

• Diagnostics - Displays diagnostic information
about a request.

• View Output - Displays an online format of the
report.

• View Log… - Displays information about the
request such as arguments used and other
technical information.

Using the Requests Window (continued)
In order to use the View Output button, your program must have paper output.
If the report file format you selected for your request has multiple MIME types
associated with it, clicking the View Output button will display a window
prompting you to select the MIME type you wish to use to view your output.
For more information on associating file formats with MIME types see:
(Help) Applied Technology > Oracle Applications System Administration >
How to View Request Status and Output > Defining the Reports Viewer.



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing Concurrent Programs and Reports
Chapter 3 - Page 22

Viewer Options Window

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Viewer Options WindowViewer Options Window

• Use this window to define the MIME types for the
output formats of your concurrent requests.

• These MIME types are used in viewing the reports.
• For each file format, you can associate one or

more MIME types.

• Use this window to define the MIME types for the
output formats of your concurrent requests.

• These MIME types are used in viewing the reports.
• For each file format, you can associate one or

more MIME types.

Use the Viewer Options Window to Define MIME Types
(N) Install > Viewer Options
You can use one MIME type to view reports of a certain format. For example,
you can view all text format reports in Microsoft Word. MIME types for
supported formats for a particular user are set by several profile options. Seeded
MIME types are:

• Viewer: Application for HTML
• Viewer: Application for PCL
• Viewer: Application for PDF
• Viewer: Application for PostScript
• Viewer: Application for Text

This MIME type is sent to a browser window when the user views a report of
that file format.
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Canceling a RequestCanceling a Request

1. Navigate to the Find Requests window:
(N) Requests > View > (B) Find

2. Select the request you want to cancel and click
Cancel Request.

3. A decision window will prompt you to verify your
action.  Click Yes.
The status of the request will change immediately
to Cancelled.

1. Navigate to the Find Requests window:
(N) Requests > View > (B) Find

2. Select the request you want to cancel and click
Cancel Request.

3. A decision window will prompt you to verify your
action.  Click Yes.
The status of the request will change immediately
to Cancelled.

Canceling a Request That Has Not Yet Completed
If you cancel a request set, then Oracle Applications automatically cancels all
requests in the set.
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Holding a RequestHolding a Request

1. Navigate to the Find Requests window:
(N) Requests > View > (B) Find

2. Select the request you want to put on hold and
click Hold Request.

3. The button will change to a “Remove Hold” button
and the status of the request will change to On
hold.

4. To remove the hold, select the request and click
Remove Hold.

1. Navigate to the Find Requests window:
(N) Requests > View > (B) Find

2. Select the request you want to put on hold and
click Hold Request.

3. The button will change to a “Remove Hold” button
and the status of the request will change to On
hold.

4. To remove the hold, select the request and click
Remove Hold.

Holding a Request That Has Not Started Running
Only requests that have not started running can be put on hold.
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Changing Request OptionsChanging Request Options

If your request has not started running, you can
change how it runs and prints its output by using the
Requests window.

If your request has not started running, you can
change how it runs and prints its output by using the
Requests window.

1. Navigate to the Find Requests window:
(N) Requests > View > (B) Find

2. Put your request on Hold.
3. Click View Details to display the Request Details

window.
4. Change the desired options and click OK.

1. Navigate to the Find Requests window:
(N) Requests > View > (B) Find

2. Put your request on Hold.
3. Click View Details to display the Request Details

window.
4. Change the desired options and click OK.
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Four Phases of a Concurrent RequestFour Phases of a Concurrent Request

InactiveInactive

Completed

Running

Pending

Four Phases of a Concurrent Request
The system administrator must periodically review the status of Oracle
Applications programs to determine what a particular program’s status is in the
lifecycle of a request.
A concurrent request has a lifecycle of either three or possibly four phases:

• Pending: The request is waiting to be run.
• Running: The request is running.
• Completed: The request has finished execution.
• Inactive: The request cannot yet be run.
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Pending PhasePending Phase

NormalNormal WaitingWaiting StandbyStandby ScheduledScheduled

Logical
database

Pending Phase
A program in the Pending phase can be in one of four statuses:

• Normal: The program is waiting for an available manager.
• Waiting: A child program is waiting for a parent to mark it ready to run.
• Standby: A program is waiting for another incompatible program in the

same logical database to complete.
• Scheduled: A program’s scheduled start time has not yet elapsed.
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Running PhaseRunning Phase

NormalNormal PausedPaused ResumingResuming TerminatingTerminating

Running Phase
A program in the Running phase can be in one of four statuses:

• Normal: Program is in progress.
• Paused: A parent program is waiting for one or more child programs to

complete.
• Resuming: A parent program is continuing after the completion of one or

more child programs.
• Terminating: The program is being terminated.
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Completed PhaseCompleted Phase

NormalNormal WarningWarning ErrorError TerminatedTerminated CanceledCanceled

Completed Phase
A program in the Completed phase can be in one of five statuses:

• Normal: Program completed successfully.
• Warning: Program completed successfully but with warning messages.
• Error: Program failed to complete successfully.
• Terminated: A running program was terminated.
• Canceled: A pending or inactive program was canceled before it started.
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Inactive PhaseInactive Phase

DisabledDisabled On HoldOn Hold No ManagerNo Manager

Inactive Phase
A program in the Inactive phase can be in one of three statuses:

• Disabled: The requested program has not been enabled for execution.
• On Hold: The requested program has been placed on hold.
• No Manager: There is no manager defined to run this type of request.
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System Administrator Monitoring
Privileges

System Administrator Monitoring
Privileges

• Place any pending request on hold.
• Take any request off hold.
• Terminate any request.
• Change the priority of a request.
• View the log file and the manager log

file.

• Place any pending request on hold.
• Take any request off hold.
• Terminate any request.
• Change the priority of a request.
• View the log file and the manager log

file.

Monitoring Privileges of the System Administrator
The system administrator’s privileges extend beyond those of the end user. The
system administrator can perform all the operations shown on the slide.
However, the system administrator cannot view the actual output of another
user’s report.
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Controlling Log File AccessControlling Log File Access

Manager 
Log

Internal 
Manager 

Log

Concurrent: Report Access Level

User
Users can view only their
own requests.

Responsibility
Users can view any request
for their responsibility.

User Profile Option Request 
Log

Log File Access
The user profile option Concurrent: Report Access Level determines the report
and log file access privileges for end users.
User: Access to reports and diagnostic log files is limited to the user who
submitted the reports.
Responsibility: Access to reports and diagnostic log files is based on the
responsibility that the user is currently using.
A user’s report and log file access privileges include:

• Viewing the completed report output online
• Viewing the diagnostic log file online (also a system administrator

privilege)
• Reprinting a completed report (if Concurrent: Save Output profile is Yes;

also a system administrator privilege)
For pending requests, only the submitter of the request or the system
administrator can view the details of the request.
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Review Log FilesReview Log Files

ManagerManager
 Log Log

Internal ManagerInternal Manager
 Log Log

RequestRequest
LogLog

Log File Descriptions
Request Log   When a user submits a request in Oracle Applications, a
concurrent manager processes the request and creates a diagnostic log file.
Request Log files document the execution of a concurrent program running as
the result of a concurrent request. The file contains the program parameters, the
start and completion times, and any error messages. Both the user and the
system administrator can access this file.
Manager Log   Manager Log files document the performance of a concurrent
manager that is running a request. The Manager Log lists each request
processed by this manager in descending order by start date and time. This file
is accessible by both the user and the system administrator.
Internal Manager Log File    This file documents the performance of the
Internal Concurrent Manager. It displays parameter values that are loaded when
the Internal Concurrent Manager is started (STARTMGR command) and
records the time that each concurrent manager is started and when each process
monitor session (or PMON) cycle is initiated. During each PMON cycle, the
Internal Concurrent Manager verifies the correct operation of each defined
concurrent manager. Only the System Administrator can access the  Internal
Concurrent Manager Log file.
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Managing Log Files and TablesManaging Log Files and Tables

To conserve space you should periodically delete
log and output files.
To conserve space you should periodically delete
log and output files.

Use the Purge Concurrent Request and/or the
Manager Data program to purge Request Log files,
Concurrent Manager Log Files, and report output
files.

Use the Purge Concurrent Request and/or the
Manager Data program to purge Request Log files,
Concurrent Manager Log Files, and report output
files.

Managing Log Files and Tables
Purging Log Data   Eventually the tables holding log information consume
disk space with data that may no longer be of use to you. To conserve disk
space, you should periodically delete Oracle Applications log files and output
files. Your company’s MIS department and application users should agree on an
archiving and file retention policy that is appropriate for your organization.
Use the Purge Concurrent Request and/or Manager Data program to purge
Request Log files, Concurrent Manager Log files, and report output files from
your product directories maintained by the operating system, as well as records
from Application Object Library tables that contain history information about
concurrent requests and concurrent manager processes.
Scheduling Purge Submissions    Run the Purge Concurrent Request and/or
Manager Data program once and automatically resubmit the program to run at
specific time intervals. Use the Parameters window to specify various criteria
with which you can control the timing and frequency of program execution.
Loss of Audit Data    Be aware that purging concurrent request information
loses audit details used by the Sign-on Audit Concurrent Requests Report.
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FND_ CONC_REQUEST
_ARGUMENTS

FND_RUN_REQUESTS

FND_CONCURRENT
_REQUESTS

FND_DUAL

FND_CONCURRENT
_PROCESSES

Purge Request ResultsPurge Request Results

Database TablesDatabase Tables Operating System FilesOperating System Files
Product_Product_TOPTOP

LOGLOG OUTOUT

IrequestIDIrequestID..reqreq Username.Username.requestIDrequestID
IrequestIDIrequestID..reqreq Username.Username.requestIDrequestID
IrequestIDIrequestID..reqreq Username.Username.requestIDrequestID
IrequestIDIrequestID..reqreq Username.Username.requestIDrequestID
IrequestIDIrequestID..reqreq Username.Username.requestIDrequestID
IrequestIDIrequestID..reqreq Username.Username.requestIDrequestID
IrequestIDIrequestID..reqreq Username.Username.requestIDrequestID

WprocessID.mgr
WprocessID.mgr

Request

Manager

Results of Purge Requests
The slide shows the database tables and the operating system files affected by a
purge request. On the Parameters form of the Purge Concurrent request and/or
Manager Data program, you can specify that either request data
(Entity=Request) or manager data (Entity=Manager) be purged. The slide
shows the effects of the different requests.
Database Table Descriptions

• FND_CONC_REQUEST_ARGUMENTS: This table records arguments
passed by the concurrent manager to each program it starts running.

• FND_RUN_REQUESTS: For submitted report sets, this table stores
information about the reports in the report set and the parameter values for
each report.

• FND_CONCURRENT_REQUESTS: This table contains a complete
history of all concurrent requests.

• FND_DUAL: This table records when requests do not update database
tables.

• FND_CONCURRENT_PROCESSES: This table records information
about Oracle Applications and operating system processes.
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Grouping Concurrent Programs and
Requests

Grouping Concurrent Programs and
Requests

Report
Report

Program
Report

Program
Report

Request GroupRequest Group

Programs and reports Programs and reports 
available to a responsibilityavailable to a responsibility

Run option
Run option
Print option

Report parameter
Print option

Report parameter

Request SetRequest Set

Programs and reports Programs and reports 
available to a user  available to a user  

Grouping Concurrent Programs and Requests
Grouping concurrent programs and other requests together allows you to control
access and streamline processing. In Oracle Applications, you group programs
and requests into request groups and request sets.
Request Groups
A request group is a collection of reports and other concurrent programs. You
use request groups to implement security at the responsibility level. Request
groups are normally associated with a responsibility, in which case they are
referred to as request security groups. Any user of a responsibility has access to
the reports in that responsibility’s request security group.
Additionally, you can define a request group to have an access code. Users must
supply this code to access the reports in the coded request group.
Request Sets
Like a request group, a request set is a collection of concurrent programs.
Request sets can also have run and/or print options, which apply to every
member of the set. Programs in a request set can share parameters; therefore a
parameter value needs to be entered only once for multiple programs. Any user
can create a request set.
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Creating a Request GroupCreating a Request Group

Request groups can include:
• All the reports and concurrent programs owned by

an application
• Individual concurrent requests
• Request sets
• Stage Functions

Request groups can include:
• All the reports and concurrent programs owned by

an application
• Individual concurrent requests
• Request sets
• Stage Functions

Request Group Creation
(N) Security > Responsibility > Request
An application name is required when defining the request set. This application
name and the request group name uniquely identify this request set. The
application name does not prevent you from assigning reports and report sets
from other applications to this group.
For more information see:
(Help) Applied Technology > Oracle Applications System Administration >
Request Groups Window.
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Using a Request Group with a CodeUsing a Request Group with a Code

Supplying a code for your request group allows you
to implement form-level security:
• Reports in a coded request group are run using a

customized Submit Request form function.
• The menu calls a Submit Request form function

that passes a request group code as an argument.
• The programs for the coded request group are

displayed in the Submit Request form list of
values.

Supplying a code for your request group allows you
to implement form-level security:
• Reports in a coded request group are run using a

customized Submit Request form function.
• The menu calls a Submit Request form function

that passes a request group code as an argument.
• The programs for the coded request group are

displayed in the Submit Request form list of
values.

The code must not contain any spaces. The combination of the application and
the code identify the request group.
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Submitting Requests: Form Compared
With Responsibility

Submitting Requests: Form Compared
With Responsibility

Specialized function Specialized function 
passes code andpasses code and
submits reportsubmits report
using request groupusing request group
with correspondingwith corresponding
code.code.

Normal report Normal report 
submission uses submission uses 
request security group.request security group.

Submitting Requests: Form Versus Responsibility
The request processing is different depending on whether you are using a
normal request group or a coded request group.
Responsibility-Based Access
This is the typical way a user submits a report. The menu prompt Run does not
pass any arguments to the Submit Requests form when the prompt is chosen.
The list of values includes all the programs in the responsibility’s request
security group.
Form-Based Access
This type of access uses a coded request group. In this method, when a modified
menu prompt is chosen, it calls a form function to pass an argument (the code)
to the Submit Requests form.
The only programs displayed in the Submit Requests list of values are those
defined to the coded request group.
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Implementing a Coded Request GroupImplementing a Coded Request Group

To implement a request group with a code:

1. Create the request group supplying a code.
2. Create a new form function.
3. Add the new function to an existing menu.

To implement a request group with a code:

1. Create the request group supplying a code.
2. Create a new form function.
3. Add the new function to an existing menu.
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Customization ExampleCustomization Example

Function name:Function name:
MRP_FNDRSRUN_LOAD_COPY_MPSMRP_FNDRSRUN_LOAD_COPY_MPS  

Function user name:Function user name:
Load/Copy/Merge MPS ScheduleLoad/Copy/Merge MPS Schedule

Menu prompt:Menu prompt:
Load/Copy/MergeLoad/Copy/Merge

Request group code:Request group code:
MRP_LOAD_COPY_MPSMRP_LOAD_COPY_MPS

Customization Example
The slide shows the values that are used in the following example.
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Creating the New Form FunctionCreating the New Form Function

1. Navigate to the Form Functions window:
(N) Application > Function

2. Enter a Function Name.  This is the name used by
the application.

3. Enter a User Function Name.  The user name will
appear in the list of values when adding the
function to the menu.

4. On the Form tab, choose Run Reports from the
Form field list of values.

5. Enter the arguments to pass to the Submit
Request form in the Parameters field.  Select Edit
Field from the Edit menu to open the editor.

1. Navigate to the Form Functions window:
(N) Application > Function

2. Enter a Function Name.  This is the name used by
the application.

3. Enter a User Function Name.  The user name will
appear in the list of values when adding the
function to the menu.

4. On the Form tab, choose Run Reports from the
Form field list of values.

5. Enter the arguments to pass to the Submit
Request form in the Parameters field.  Select Edit
Field from the Edit menu to open the editor.

Creating the Form Function
Type is a nonvalidated field used to enter a description of the function’s use.
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Passable Request ParametersPassable Request Parameters

SUBMIT_ONCE
LOOKUP
TITLE
USER_ORG, ORG_ID, ORG_NAME, ORG_CODE,
CHART_OF_ACCOUNTS

REQUEST_GROUP_CODE
REQUEST_GROUP_APPL_SHORT_NAME

CONCURRENT_PROGRAM_NAME
PROGRAM_APPL_SHORT_NAME

REQUEST_SET_NAME
SET_APPL_SHORT_NAME

Passable Request Parameters
The slide shows the parameters you can pass in your new function. Several of
the parameters are paired; these parameters must be used together. Remember
that when the request group was created, it was associated with an application.
You must pass both the code and the short name of the application for the
system to identify the correct request group.
For a complete explanation of these parameters, see:
(Help) Applied Technology > Oracle Applications System Administration >
Overview of Concurrent Programs and Requests >
Organizing Programs into Request Groups >
Customizing the Submit Requests Window,
Customizing the Submit Requests Window using Codes.
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Adding the Function to the MenuAdding the Function to the Menu

1. Navigate to the Menus window:
(N) Application > Menu

2. Enter a sequence number for the new item.
3. Enter a navigator prompt.  Make the first letter of

the prompt unique in the menu.  This enables
AutoReduction to work more efficiently.

4. Choose the user function name of your function
from the list of values.

5. Click Save.
6. Click View Tree… to see your new menu structure

in the Menu Viewer.

1. Navigate to the Menus window:
(N) Application > Menu

2. Enter a sequence number for the new item.
3. Enter a navigator prompt.  Make the first letter of

the prompt unique in the menu.  This enables
AutoReduction to work more efficiently.

4. Choose the user function name of your function
from the list of values.

5. Click Save.
6. Click View Tree… to see your new menu structure

in the Menu Viewer.
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Defining a Request SetDefining a Request Set

Enter Request Set Name

Define a Stage

Enter Requests for Stage

Enter Request Parameter

Link Stages

Save Changes

Defining Request Sets
By defining request sets, you can submit the same set of requests regularly with
a single transaction. Use the Request Set window to create and edit request sets.
You can also use the Request Set Wizard to create simple request sets.



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing Concurrent Programs and Reports
Chapter 3 - Page 46

Request Set Stages

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Request Set StagesRequest Set Stages

Stage 1
Request 1

Stage 2
Request 2

Stage 3
Request 3

Stage 1
Request 1
Request 2

Stage 2
Request 3

Stage 3
Request 4
Request 5

Organizing Requests with Stages
Request sets are divided into one or more stages, which are linked to determine
the sequence in which your requests are run. Each stage consists of one or more
requests that you want to run in parallel (at the same time in any order). For
example, in the simplest request set structure, all requests are assigned to one
stage. This allows all requests to run in parallel.
To run requests in sequence, assign requests to different stages and then link the
stages in the order that you want the requests to run.
The concurrent manager allows only one stage in a request to run at a time.
When one stage is complete, the next stage is submitted. A stage is not
considered complete until all of the requests in the stage are complete. One
advantage of using stages is the ability to run several requests in parallel and
then move sequentially to the next stage. This enables you to create more
versatile and efficient request sets.
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 Stage Status Stage Status

Stage 2
Request 4

Stage 3
Request 5

Stage 4
Request 6

SuccessSuccess

WarningWarning

ErrorError

Stage 1
Request 1
Request 2
Request 3
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Linking of StagesLinking of Stages

• No restrictions on linking stages within a set
• Links can point to any other stage in the set
• Two or more links can point to the same stage
• Request set is completed when a stage ends with

no further links to be followed

• No restrictions on linking stages within a set
• Links can point to any other stage in the set
• Two or more links can point to the same stage
• Request set is completed when a stage ends with

no further links to be followed
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Defining Request Sets
Step 1: Enter Request Set Name

Defining Request Sets
Step 1: Enter Request Set Name

1. Navigate to the Submit a New Request window:
(N) Requests > Set

2. Enter the name of the request set.
3. Enter a unique Set Code for your request set.
4. Choose the application with which to associate

your request set from the list of values.
5. Enter a Description for your request set.

1. Navigate to the Submit a New Request window:
(N) Requests > Set

2. Enter the name of the request set.
3. Enter a unique Set Code for your request set.
4. Choose the application with which to associate

your request set from the list of values.
5. Enter a Description for your request set.

Defining A Request Set
The Owner field defaults to your user name and can be changed only by your
system administrator.
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Defining Request Sets
Step 1: Enter Request Set Name

Defining Request Sets
Step 1: Enter Request Set Name

6. Enter Active Dates From and To fields to define an
effective period.

7. Enable or disable Print Together as appropriate.
8. Enable Allow Incompatibility as appropriate.
9. Click Define Stages to define the stages for your

request set.

6. Enter Active Dates From and To fields to define an
effective period.

7. Enable or disable Print Together as appropriate.
8. Enable Allow Incompatibility as appropriate.
9. Click Define Stages to define the stages for your

request set.

Defining A Request Set (continued)
If the current date is outside the Active Dates From and To range you define,
the request set will not be available in the Submit Requests window.
Selecting the Print Together check box will send all your requests to the printer
together when they complete.
Selecting the Allow Incompatibility check box allows your system
administrator to specify programs that are incompatible with this request and
may not run with it.
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Defining Request Sets
Step 2: Define a Stage
Defining Request Sets
Step 2: Define a Stage

1. Enter a name for your stage.
2. Enter a description for your stage.
3. Enter a short code for the stage.
4. Use the LOV in the function field to select a

function.
5. Enable the Return Value of this Stage Affects the

Set Outcome check box as appropriate.
6. Enable the Allow Incompatibility check box as

appropriate.
7. Click Requests to display the Stage Requests

window.

1. Enter a name for your stage.
2. Enter a description for your stage.
3. Enter a short code for the stage.
4. Use the LOV in the function field to select a

function.
5. Enable the Return Value of this Stage Affects the

Set Outcome check box as appropriate.
6. Enable the Allow Incompatibility check box as

appropriate.
7. Click Requests to display the Stage Requests

window.

Stages
(N) Requests > Set > (B) Define Stages
Defining Stages
The value for the Display Sequence field is defaulted in sequence as you enter
your stages. You may change the display order of the stages by modifying the
field.
The default value for the Function field is Standard Evaluation that bases its
completion status on the normal completion status of the requests it contains.
If you select the Return Value check box for more than one stage, the
completion status of the request set will equal the completion status of the last
of these stages to run.
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Defining Request Sets
Step 3: Enter Requests for Stage

Defining Request Sets
Step 3: Enter Requests for Stage

1. Select the report or program that you want to
include in this stage.

2. Specify the number of copies of output to print,
the style to print, and the printer to print to.

3. Enable the Save check box as appropriate.
4. Enable the Allow Stage Function to Use This

Program’s Results check box as appropriate.
5. Click Parameters to display the Request

Parameters window.

1. Select the report or program that you want to
include in this stage.

2. Specify the number of copies of output to print,
the style to print, and the printer to print to.

3. Enable the Save check box as appropriate.
4. Enable the Allow Stage Function to Use This

Program’s Results check box as appropriate.
5. Click Parameters to display the Request

Parameters window.

Defining Stages (continued)
(N) Requests > Set > (B) Define Stages > (B) Requests
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Defining Request Sets
Step 4: Enter Request Parameter

Defining Request Sets
Step 4: Enter Request Parameter

1. Select the Display check box as appropriate.
2. Select the Modify check box as appropriate.
3. Use the Shared Parameter field to set a default

value for a parameter that occurs in more than one
report or program of a request set.

4. Save your work.

1. Select the Display check box as appropriate.
2. Select the Modify check box as appropriate.
3. Use the Shared Parameter field to set a default

value for a parameter that occurs in more than one
report or program of a request set.

4. Save your work.

Request Parameters
((N) Requests > Set > (B) Define Stages > (B) Requests > (B) Parameters
Request Parameters Window
Use the Request Parameters window to customize the parameter values of a
specific request in a request set. The fields at the top of the Request Parameters
window list general information about the current request set for which you can
customize the parameter values. The multirow portion of the window lists the
parameters for that request.

• The Sequence and Prompt fields are display only.
• Selecting the Display check box specifies that you can see a request

parameter at submission time.
• Selecting the Modify check box to specifies that you can insert or change

the value for a request parameter at submission time.
• Using the Shared Parameter field sets a default value for a parameter that

occurs in more than one report or program of a request set. Use the shared
parameter label to set an initial default value for all occurrences of the
same parameter so that you can avoid typing the same value all over again
for every occurrence of the parameter.
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Step 5: Link Stages

Defining Request Sets
Step 5: Link Stages

1. Navigate to the Link Stages window:
(N) Requests > Set > (B) Link Stages

2. Choose the start stage from the LOV of the stages
you defined for your set.

3. Enter the stages that you want to run in the
Success, Warning, and Error columns.

4. Click Done when you are finished.

1. Navigate to the Link Stages window:
(N) Requests > Set > (B) Link Stages

2. Choose the start stage from the LOV of the stages
you defined for your set.

3. Enter the stages that you want to run in the
Success, Warning, and Error columns.

4. Click Done when you are finished.

Linking Stages in a Request Set
Success, Warning, and Error columns - To ensure that a particular stage follows
the preceding stage regardless of the completion status, enter the desired stage
in all three columns. To stop the request set if a stage ends in Error, leave the
Error column blank. Any time you do not specifically indicate which stage
should follow for a completion status, the request set will exit on that
completion status.
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1. Navigate to the Submit Request Set window:
(N) Requests > Run > (Option) Request Set > (B) OK

2. Follow the instructions for Submitting Requests
presented earlier.

1. Navigate to the Submit Request Set window:
(N) Requests > Run > (Option) Request Set > (B) OK

2. Follow the instructions for Submitting Requests
presented earlier.

Who Can Use a Request Set
After you define a request set, it becomes your private request set. You can run
it as long as you have access to a standard Submit Request window that does
not limit access to specific requests.
Other users can run the request set only if your system administrator assigns the
request set to their responsibility’s request group. It is possible to have a request
set in your request group that contains individual requests that are not in your
request group, but you can only edit request sets that you own. You can add any
requests in your request group to the request set. You can delete any request
from the request set, regardless of whether that request is in your request group.
To update information in about an individual request in the request set,
however, the request set must be in your request group.
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User Request Set PrivilegesUser Request Set Privileges

User:

Create Edit Sets
Contain

Own 
Created

Sets

Change
Owners

Yes Own
Request 
Group’s 
Reports

Yes No

Privilege:

Request Set Privileges
You can control request set ownership to manage request set editing and run
privileges.
Application User Editing Privileges

• Application users define a request set by selecting reports or other
concurrent programs from their current responsibility’s request security
group.

• Application users automatically own the sets that they create.
• Application users can always edit the sets that they own. They cannot edit

a request set that they do not own.
Request Sets and Request Security Groups

• After changing responsibilities, application users can add reports from
their current (new) responsibility’s request security group to a request set
that they own.

• After changing responsibilities, application users can delete reports from a
request set that they own, regardless of whether the report is in the new
responsibility’s request security group.
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System Administrator
Request Set Privileges
System Administrator
Request Set Privileges

System:

Change
 Set

Owners

All Any 
Reports No Yes

Create

Yes

Edit Sets
Contain

Own 
Created

Sets
Privilege:

System Administrator Request Set Privileges
System administrators can edit and assign ownership of any request set.
System Administrator Editing Privileges

• System administrators can define or edit a request set to include any
standard submission report or concurrent program.

• System administrators do not automatically own the request sets that they
define. Request sets defined by a system administrator initially do not
have an owner.

• System administrators can assign or change ownership of any request set.
• If a request set is assigned to an owner but not to the owner’s request

security group as well, the reports contained in the request set are
available only to the owner.

• System administrators can edit any request set, whether the set is owned or
not.

• System administrators can assign any request set to any request security
group, even if the request set contains individual reports that are not in the
request security group. However, this privilege provides the members of a
responsibility access to reports and programs outside their request security
group.
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You should now be able to do the following:
• Submit and monitor a request
• Create a request group and assign it to a

responsibility
• Create a coded request group
• Create a request set
• Manipulate ownership of a request set

You should now be able to do the following:
• Submit and monitor a request
• Create a request group and assign it to a

responsibility
• Create a coded request group
• Create a request set
• Manipulate ownership of a request set

Lesson Summary
In this lesson you learned how to use request groups to control access to reports
and concurrent programs. Additionally you learned how individual users can
define request sets to streamline processing by setting default values for
parameters and sharing parameter values among multiple reports.
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Administering Concurrent Requests
Practice Instructions

As system administrator you have been assigned
to submit the following user requests:

1. Submit the Active Responsibilities report to run
now and not again.

2. Submit the Active Users report to run at a one-
minute interval.

3. Submit the Report Sets report to run one week
from today.

4. Submit the Work Shifts report to run once a day at
2:00 PM for one week only.

As system administrator you have been assigned
to submit the following user requests:

1. Submit the Active Responsibilities report to run
now and not again.

2. Submit the Active Users report to run at a one-
minute interval.

3. Submit the Report Sets report to run one week
from today.

4. Submit the Work Shifts report to run once a day at
2:00 PM for one week only.

Instructions
Submit these requests and perform the following checks to ensure that processing was
completed.

1. View one of the reports that completed.
2. Look at the Report Diagnostics of a report that completed successfully.
3. Review the Request Log of a report that completed successfully.

Additional user requests prompt you to do the following:
1. Cancel one of your pending requests, but do not save. Uncancel the pending

request and put it on hold. Then take it off hold.
2. Reprint one of the completed reports with 0 copies defined.
3. Cancel the request that was submitted to run once every minute.
4. Now, save all of these changes.

Practice Solutions
Submit Your Requests

1. Navigate to (N) Concurrent >Requests > (B) Submit a New Request.
2. Click Submit a New Request and then click OK to submit a single request.
3. Submit the three reports listed in your instructions, using the list of values to

select them.
View Your Requests
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4. Navigate to (N) Concurrent > Requests.
5. Click Find to pull up all of your submitted requests.
6. Use the appropriate buttons on this form to perform each of the tasks listed in the

instructions.
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Defining a Request Group Practice
Instructions

• In order to limit your system administrator’s
access to all reports while allowing him to run
some regularly required reports for the finance
group, you have decided to define a request group
for him to use.

• Remember to attach the request group to your
temporary system administrator and then sign on
using his signon to test your changes.

• In order to limit your system administrator’s
access to all reports while allowing him to run
some regularly required reports for the finance
group, you have decided to define a request group
for him to use.

• Remember to attach the request group to your
temporary system administrator and then sign on
using his signon to test your changes.

Instructions
Group Name: Your Company Name Request
Group_________________________
Application: Your Company Name Custom Application
Code: Skip this field
Description: Your Company Name Reports
Requests Type: Application
Requests Name: Application Object Library
Requests Type: Program
Requests Name: Invoice on Hold Report
Requests Type: Set
Requests Name: Function Security Reports

Practice Solutions
Define a Request Group

1. (N) Navigate to Security > Responsibility > Request.
2. Enter the data from the instructions in the appropriate fields in the

window.
3. Click Save to save your work.
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Attach the Request Group to Your Temp System Administrator
Responsibility

4. Navigate to (N) Responsibility > Define.
5. Query to find your Temp System Administrator responsibility.  Choose

your request group from the list of values for the Request Group Name
field.

6. Click Save to save your work.
Test Your Request Group
Test that the request group has been appropriately assigned and that reports now
exist that can be run under your Temp System Administrator responsibility.

7. Select (M) File > Log on as a Different User...
8. Sign on with your Temp System Administrator user name and password.
9. Navigate to (N) Requests > Run. Click OK to accept the default.
10. Note the reports that now exist in the list of available reports for you to

run.
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Defining a Coded Request Group Practice
Instructions

• Define an additional request group for your
assistant system administrator to use.

• This will be a request group with a code for special
access.

• Define an additional request group for your
assistant system administrator to use.

• This will be a request group with a code for special
access.

Instructions
Define an additional request group for your assistant system administrator to
use. This will be a request group with a code for special access. Use the
information provided below.

Group Name: Your Company Name Request Group 2
_________________________

Application: Your Company Name Custom Application
Code: Your initials plus your terminal number

_______________________________
Description: Your Company Name Reports
Request Type: Program
Request Name: Journal Entries Report

Define the function, assign a user name to the function, and add the new
function to your first-level custom menu as function number five. Use the
information provided below.

Function: Your Application Short Name_REPORTS
User Function Name: Your Company Name Reports
Type: Form
Description: Your Company Name Reports
Form: Run Reports
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Parameters: TITLE = Your Company Name Reports
REQUEST_GROUP_CODE = Your initials plus your terminal
number
REQUEST_GROUP_APPL_SHORT_NAME = The code used to
register your custom application.

Practice Solutions
1. Navigate to (N) Security > Responsibility > Request.
2. Enter the data from the instructions in the appropriate fields in the

window.
3. Click Save to save your work.
Define the Function
4. Navigate to (N) Application > Function.
5. Enter the data from the instructions in the appropriate fields in the

window. Data will be entered on the Description tab region and on the
Form tab region.
Hint: Use the Edit Field icon when you are in the Parameters field to type
in the specific logic as described in the instructions.

6. Click Save to save your work.
Add the New Function to the Menu.
7. Navigate to (N) Application > Menu.
8. Query up your first-level custom menu.
9. Add your function as number five.
10. Type Your Company Name Reports in the Name Navigator Prompt field.
11. Attach your new function by calling it up using the User Function Name.
12. Click Save to save your work.
Test Your Changes
13. Select (M) File > Log on as a Different User... to sign on again as the

System Auditor to see your new function on the menu.
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Using Request Sets Practice InstructionsUsing Request Sets Practice Instructions

In order to make your new assistant more efficient
in running regularly required reports, you have
decided to define a request set for your assistant
system administrator to use.

In order to make your new assistant more efficient
in running regularly required reports, you have
decided to define a request set for your assistant
system administrator to use.

Instructions
Set Name: Your Company Name’s Request Set
Set Code: Your initials plus your terminal number
Application: Your Company Name Custom Application
Description: Your Company Name Reports
Owner: Your Temp Sys Admin User Name
Use the Requests Set Wizard to complete the setup for your request set; accept
all of the default values.
Include the following programs in your request set:

• Users of a Responsibility
• Reports and Sets by Responsibility
• Report Group Responsibilities

Practice Solutions
1. Navigate to (N) Requests > Set.
2. Enter the data from the instructions in the appropriate fields in the

window.
3. Click Save.
4. Select the Request Set Wizard.
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5. Accept the default value and select Next to continue using the Request Set
Wizard.

6. Continue selecting Next until you see the window asking you to choose a
name and an application for your request set.

7. Enter the Set name, Application, and Description as described in the
instructions.

8. Select Next. The next window asks you to enter the concurrent programs
to include in your request set.

9. Enter the programs listed in the instructions.
10. Select Finish. A Note appears telling you that your request set has been

created and saved. Click OK.
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Managers
Chapter 4
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Define managers and their work shifts
• Specialize managers to run only certain programs
• Classify a program as a request type
• Control concurrent managers
• Manage parallel concurrent processing
• Use conflicts domains to maximize throughput
• Monitor concurrent processing using Oracle

Enterprise Manager

After completing this lesson, you should be able to
do the following:
• Define managers and their work shifts
• Specialize managers to run only certain programs
• Classify a program as a request type
• Control concurrent managers
• Manage parallel concurrent processing
• Use conflicts domains to maximize throughput
• Monitor concurrent processing using Oracle

Enterprise Manager

Lesson Aim
The Oracle system administrator is the end user’s first point of contact for
system questions. The system administrator should be able to monitor the
processing of requests and deal with any problems. He or she should also be
able to balance workloads to provide the optimum processing environment for
users. This lesson teaches you how to monitor and control system processing
and also how to plan and schedule your workload.
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Concurrent
manager

Defining Managers and Their
Work Shifts

Defining Managers and Their
Work Shifts

User submitsUser submits
request to run request to run 
program abcprogram abc

ConcurrentConcurrent
manager manager 

startsstarts
program abcprogram abc

Run program abc

Run program ...
Run program ...
Run program ...

Run program ...

Request Table

Managers and Their Work Shifts
A concurrent manager is itself a concurrent program that starts other concurrent
programs running. When an application user submits a request to run a program,
the request is entered into a database table that lists all of the requests.
Concurrent managers read requests from the table and start programs running.
Concurrent managers can be defined to process only certain types of requests
and to operate during certain times of the day.
Scheduling Requests  You can schedule when a manager operates by defining
one or more work shifts and associating the manager with a work shift.
Segregating Requests  You can define specialization rules to identify the kinds
of requests that a manager will read. Specialize managers so that they only read
requests to start certain kinds of programs.
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A work shift is a labeled duration of time:
• Hours in a day
• Days in a week
• Specific days in the year

A work shift is a labeled duration of time:
• Hours in a day
• Days in a week
• Specific days in the year

Defining Work Shifts
(N) Concurrent > Manager > Workshifts
A concurrent manager operates only during its specified work shift. Use
military time notation to define a work shift—that is, use 24 hours rather than
12.
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Over Time

Balancing Process Workload
Over Time

6 AM6 AM
06:0006:00

12 PM12 PM
12:0012:00

6 PM6 PM
18:0018:00

11:5911:59
23:5923:59

12 AM12 AM
00:0000:00

Day work shiftDay work shift
three processesthree processes

Night work shiftNight work shift
six processessix processes

GraveyardGraveyard
work shiftwork shift

six processessix processes

Balancing Process Workload
You can create multiple work shifts for a concurrent manager to regulate the
number of operating system processes that the manager starts up at different
times of the day and different days of the week.
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Priority Work Shift Definition Example

1

2

3

4

5

6

Specific date and 
range of times
Specific date but 
no range of times
Range of days and
range of times
Range of days but 
no range of times
Range of times but 
no date and no range of days
Standard work shift; no date, 
days, or time defined

April 15, 2001
8:00am–5:00pm

April 15, 2002

Monday–Friday
8:00am–5:00pm

Monday–Friday

8:00am–5:00pm

24 hours a day
365 days a year

Overlapping Workshifts
When work shifts overlap, the work shift with the more specific time period
takes effect for the overlapping time period. For example, a work shift for
January 1 overrides a work shift from 9:00 am to 5:00 PM every Monday
through Friday.
When work shifts with the same priority overlap, the work shift with the largest
number of target processes takes effect.



Copyright © Oracle Corporation, 2000. All rights reserved.

Administering Concurrent Managers
Chapter 4 - Page 8

Defining a Concurrent Manager

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Concurrent
Manager
Definition

Defining a Concurrent ManagerDefining a Concurrent Manager

Run Program ARun Program A

Run Program BRun Program B

Specialization Rules
Work Shifts

Target Processes
Specialization Rules Specialization Rules 
define which requests define which requests 
a manager can read.a manager can read.

For each work shift,For each work shift,
Target Processes is Target Processes is 
the maximum number the maximum number 
of programs the managerof programs the manager
can run simultaneously.can run simultaneously.

Work shifts define Work shifts define 
when a managerwhen a manager
reads requestsreads requests
(is enabled).(is enabled).
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Defining a Concurrent ManagerDefining a Concurrent Manager

You can define as many concurrent managers as you
want.  To define a manager:
• Assign a predefined library of immediate

concurrent programs to your manager
• Assign work shifts to your manager, which

determine what days and times the manager works
• For each workshift, define the maximum number of

operating system processes the manager can run
concurrently to read requests during the work shift

• Specialize your manager to read only certain kinds
of requests

You can define as many concurrent managers as you
want.  To define a manager:
• Assign a predefined library of immediate

concurrent programs to your manager
• Assign work shifts to your manager, which

determine what days and times the manager works
• For each workshift, define the maximum number of

operating system processes the manager can run
concurrently to read requests during the work shift

• Specialize your manager to read only certain kinds
of requests

Defining a Concurrent Manager
(N) Concurrent > Manager > Define
The Parallel Concurrent Processing Details region of this window is discussed
in a later lesson.
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Concurrent Managers Window : Program
Libraries

Concurrent Managers Window : Program
Libraries

• A program library contains immediate concurrent
programs that can be called by your manager.

• Each manager can only run the immediate
programs included in its program library.

• An immediate concurrent program must be
registered with a program library before it can be
run by a manager.

• Application developers using Oracle Application
Object Library can register concurrent programs
with a program library, system administrators
cannot.

• A program library contains immediate concurrent
programs that can be called by your manager.

• Each manager can only run the immediate
programs included in its program library.

• An immediate concurrent program must be
registered with a program library before it can be
run by a manager.

• Application developers using Oracle Application
Object Library can register concurrent programs
with a program library, system administrators
cannot.

Concurrent Managers
(N) Concurrent > Manager > Define
Immediate Programs and Spawned Programs
Immediate concurrent programs are C or PRO*C subroutines linked with
concurrent managers. Most concurrent programs are spawned as independent
processes at run time instead of running as subroutines. If you are defining a
new concurrent program, you should run the program as a spawned program
rather than as an immediate program.
Examples of these are:

• FNDLIBR: Contains immediate concurrent programs used by Oracle
Applications Object Library.

• INVLIBR: Contains immediate concurrent programs used by Oracle
Inventory.

• MFCLIBR: Contains immediate concurrent programs used by Oracle
Manufacturing.

• PALIBR: Contains immediate concurrent programs used by Oracle
Projects.
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Defining a Transaction ManagerDefining a Transaction Manager

• Some forms require synchronous processing of
particular requests.  Transaction managers handle
these synchronous requests.

• Each transaction manager is associated with a
particular data group.  Transaction managers can
run requests submitted only from a responsibility
associated with the same data group.

• Use the Concurrent Managers window to define a
transaction manager.

• Some forms require synchronous processing of
particular requests.  Transaction managers handle
these synchronous requests.

• Each transaction manager is associated with a
particular data group.  Transaction managers can
run requests submitted only from a responsibility
associated with the same data group.

• Use the Concurrent Managers window to define a
transaction manager.

Creating Custom Transaction Managers
(N) Concurrent > Manager > Define
Because forms must be precoded to submit synchronous requests, you do not
usually need to create custom transaction managers. If you create custom data
groups, you should create custom transaction managers that use your custom
data group. This applies only if the responsibilities using your custom data
group access the forms submitting synchronous requests. Consult your product
documentation. In general, you should create custom transaction managers
whenever your custom data groups prevent your seeded transaction managers
from operating.
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Assigning Workshifts to a ManagerAssigning Workshifts to a Manager

• You can define the maximum number of programs
that a concurrent manager can run simultaneously
by assigning a number of target processes to a
work shift.

• Balance program processing across different time
periods by assigning your manager a different
number of target processes during different work
shifts.

• You can define the maximum number of programs
that a concurrent manager can run simultaneously
by assigning a number of target processes to a
work shift.

• Balance program processing across different time
periods by assigning your manager a different
number of target processes during different work
shifts.

Assigning Work Shifts to a Manager
(N) Concurrent > Manager > Define > (B) Workshifts
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Specializing a Concurrent ManagerSpecializing a Concurrent Manager

You can use specialization rules to restrict a
concurrent manager to process only certain types
of requests:

• Define specialization rules to identify the types of
requests that a manager will read.

• Without specialization rules, a manager reads
requests to start any concurrent program.

You can use specialization rules to restrict a
concurrent manager to process only certain types
of requests:

• Define specialization rules to identify the types of
requests that a manager will read.

• Without specialization rules, a manager reads
requests to start any concurrent program.

Specializing a Concurrent Manager
(N) Concurrent > Manager > Rule
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Specializing a Concurrent Manager:
Combined Rules

Specializing a Concurrent Manager:
Combined Rules

Whenever you have a generalized rule that is
appropriate for many different concurrent
managers, you should consider turning the rule
into a combined rule.

• A combined rule is a specialization rule with its
own name.

• Combined rules provide easy maintenance.

Whenever you have a generalized rule that is
appropriate for many different concurrent
managers, you should consider turning the rule
into a combined rule.

• A combined rule is a specialization rule with its
own name.

• Combined rules provide easy maintenance.

Combined Rules
(N) Concurrent > Manager > Rule
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Specialization RulesSpecialization Rules

ActionAction ApplicationApplication NameName

IncludeInclude
ExcludeExclude

ActionAction
TypeType

UserUser

Oracle IDOracle ID
ProgramProgram
request Typerequest Type

Combined RuleCombined Rule Application Application 
namename

VariesVaries

Exclude
Include Oracle ID Oracle Purchasing

Request Type Month-End RepOracle Purchasing

Example Rules:

Action Application Name

Include

Exclude

Action Type

User

Oracle ID

Program

Request type

Combined Rule Application Varies

N/A Varies

Varies

Varies

Varies

Name

Name

N/A

Defining Specialization Rules
Use actions and qualifications to define specialization rules. An action defines a
concurrent manager’s behavior toward the request.
Include and Exclude Actions

• The manager runs requests that are included.
• The manager does not run requests that are excluded.
• Exclusion rules override inclusion rules.

Example Rules
The example rules would result in a manager’s reading requests for all programs
assigned to Oracle Purchasing except programs defined with the request type
Month-End Rep.
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Action TypesAction Types

Combined rule

User

Oracle ID

Program

Request type

Action Types
Use action types to specify the actions of a manager. An action type specifies
the type of request to which an action refers.

• Programs that connect to a specific Oracle Applications account
(Oracle ID).  For example, you could include for processing all programs
that connect to the Oracle Payables account AP1.

• Specific programs by name. For example, you could include for
processing the Oracle General Ledger program Trial Balance-Budget.
When using an action type of program, you specify the application and the
program name.

• Certain request types. For example, you could include for processing all
programs that had been defined as a request type of Month-End Reports.

• Programs requested by certain users. For example, you could include
for processing all programs requested by the user Sysadm.

• Combined rule. A combined rule combines more than one action to
generate a single rule.
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Combining Multiple Actions
Within Rules

Rule Type Action
Effects of
Multiple Actions

Relationship
to Similar
Actions

Specialization
rule

Combined
rule

INCLUDE

EXCLUDE

INCLUDE

EXCLUDE

More requests
read

Fewer requests
read

Fewer requests
read

Fewer requests
read

OR

AND

AND

AND

Combining Multiple Actions in Rules
• Multiple include actions in a combined rule behave differently from other

multiple include actions in a specialization rule.
• A specialized include rule is associated with a specific concurrent

manager. A combined include rule is an independent rule possibly
associated with multiple managers.

• Multiple specialized include rules create OR clauses, allowing more
requests to be read by the manager.

• Multiple combined include rules create AND clauses, further restricting a
manager from reading the request.
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You can classify as request types programs that
users request at the same time or that require similar
processing times:

• Use request types to save time when defining the
specialization rules of a concurrent manager.

• Use request types to let certain programs run
without having to wait for other types of programs
to finish processing.

You can classify as request types programs that
users request at the same time or that require similar
processing times:

• Use request types to save time when defining the
specialization rules of a concurrent manager.

• Use request types to let certain programs run
without having to wait for other types of programs
to finish processing.

Defining Request Types
(N) Concurrent > Program > Types
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Assign the request type to the 
appropriate concurrent programs.

Define a request type.

Use the request type in 
a specialization rule.

How to Define and Use Request Types
There are three steps in defining and using request types:

1. Identify a category of programs according to some criterion. Define a
request type for that category of programs.

2. Identify a concurrent program according to the new request type.
3. Use the new request type in a manager’s specialization rule.
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Logical
database

Program A Program B

Logical
database

Program A

Domain 1 Domain 2

The concept of separate domains attempts to
maximize concurrency and thereby, the throughput of
the system in the suite of applications.

The concept of separate domains attempts to
maximize concurrency and thereby, the throughput of
the system in the suite of applications.

Program B

The Purpose of Conflicts Domains
Concurrent processing resolves and imposes conflicts and constraints within a
domain and not across. That is, two incompatible programs A and B will not run
concurrently when they are submitted within the same domain. But, if A is
submitted within domain D1 and B is submitted within D2, they may run
concurrently.

Defining Conflicts Domains
(N) Concurrent > Conflicts Domains
To prevent two programs from concurrently accessing or updating the same
data, you have to know where in terms of data, they are incompatible. A
Conflict Domain identifies the data that creates the incompatibility.
In Oracle Applications data is stored in database tables that belong to a
particular application. Each table may also contain information used to
determine what conditions need to be met to access the individual records.
These conditions may consist of one or more of the following data groupings:

• SOB - based on the profile option GL_SET_OF_BOOKS
• Multiple installations (referred to as MSOB)
• Multiple Operating units (determined by profile option

MO_OPERATING_UNIT) (referred to as MULTIORG)
• Multiple Orgs (determined by profile option INV_ORGANIZATION_ID,

used by Manufacturing applications)
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• HR may use business group as a conflict domain
• FA may use FA book

A conflict domain is an abstract representation of the groupings used to partition
your data. There is no limit to the number of domains that can be defined, but
excessive domains may hurt performance.
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• All programs are assigned to a conflict domain
when they are submitted.

• The concurrent manager assigns a conflict domain
based on the following hierarchy:
– A program parameter
– The profile option Concurrent: Conflicts Domain
– Standard default domain

• All programs are assigned to a conflict domain
when they are submitted.

• The concurrent manager assigns a conflict domain
based on the following hierarchy:
– A program parameter
– The profile option Concurrent: Conflicts Domain
– Standard default domain

Processing Conflict Domains
All programs are assigned a conflict domain when they are submitted. If a
domain is defined as part of a parameter the concurrent manager will use it to
resolve incompatibilities. If the domain is not defined by a parameter, the
concurrent manager uses the value defined for the profile option Concurrent:
Conflicts Domain. Lastly, if the domain is not provided by a program parameter
and the Concurrent: Conflicts Domain profile option has not been defined, the
Standard domain is used. The Standard domain is the default for all requests.
Each request submitted uses parameters that identify the records that it will
access. For programs that are defined with incompatibility rules the conflict
domain parameter is used additionally. The conflict domain may be set
automatically based on such variables as logon ID, set of books, or the
organization the user is working in. The conflict domain parameter may in some
cases be selected in the parameters field of the Submit Requests form.
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Managers

Control Functions of Concurrent
Managers

Control concurrent managers by activating or
deactivating one or all of the managers:

(N) Concurrent > Manager > Administer

Control concurrent managers by activating or
deactivating one or all of the managers:

(N) Concurrent > Manager > Administer

• Activate All Managers Simultaneously
• Deactivate All Managers Simultaneously
• Activating and Deactivating Individual Managers

• Activate All Managers Simultaneously
• Deactivate All Managers Simultaneously
• Activating and Deactivating Individual Managers

Activating and Deactivating Concurrent Managers
You can control concurrent managers by activating or deactivating one or all of
the managers.
Activate All Managers Simultaneously  When you activate the Internal
Concurrent Manager, it starts up all the concurrent managers. You can activate
the Internal Concurrent Manager from the operating system.
Deactivate All Managers Simultaneously  When you deactivate the Internal
Concurrent Manager, it shuts down all the concurrent managers. You can
deactivate the Internal Concurrent Manager from either the Administer
Concurrent Managers window or the operating system.
Activating and Deactivating Individual Managers  You can activate
individual concurrent managers by using the Administer Concurrent Managers
window. The Internal Concurrent Manager must be active for an individual
manager to be active. Deactivate individual concurrent managers by using the
Administer Concurrent Managers form.

Internal Manager Control Functions:
Activate Concurrent Manager    Activates the Internal Concurrent Manager
and all other managers except managers that were deactivated individually
using Deactivate Concurrent Manager.
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Verify Concurrent Manager Status   Manually executes the process
monitoring (PMON) cycle.
Deactivate Concurrent Manager   Deactivates the Internal Concurrent
Manager and all other managers.
Terminate Requests and Deactivate Manager    All running requests running
concurrent programs) are terminated, and all managers are deactivated.

Any Other Manager Control Functions
Activate Concurrent Manager   If the manager is defined to work in the
current work shift, it starts  immediately.  Cancels Deactivate Concurrent
Manager and Terminate Requests and Deactivate Manager Requests.
Restart Concurrent Manager   Internal manager rereads the manager’s
definition and the rules for concurrent program incompatibilities.
Deactivate Concurrent Manager   Deactivates the manager.  All requests
(concurrent programs) currently running are allowed to be completed before the
manager shuts down.  A manager will not restart until you select the manager
and choose Activate Concurrent Manager.
Terminate Request and Deactivate Manager   All running requests (running
concurrent programs) handled by the manager are terminated.  Once deactivated
a manager will not restart until you select the manager and choose Activate
Concurrent Manager.
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Node

Node

Node

Database

ClientNode

Managing Parallel Concurrent Processing
You can distribute concurrent processing across multiple nodes in a cluster,
massively parallel, or homogeneous networked environment.
Benefits of Parallel Concurrent Processing

• High Performance: Processes can run on multiple nodes to improve
throughput.

• Fault Tolerance: Processes can continue running on available nodes even
when one or more nodes fail.

• Adaptability: Integrate with platform-specific batch queue and load-
balancing systems to maximize concurrent processing performance on a
particular platform.

• Single Point of Control: Managers can be administered from any node.
Nodes

• Each node consists of one or more processors (CPUs) and its associated
memory.

• Each node has its own memory that is not shared with other nodes.
• Each node operates independently of other nodes except when sharing

resources.
Nodes and Concurrent Managers
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With parallel concurrent processing, one or more managers can run on one or
more nodes. You decide where concurrent managers run when configuring the
system. You can define any set of specialization rules and apply them across
nodes in any way desired.
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Concurrent
manager

Internal 
Monitor
Process

Concurrent
manager

Concurrent
manager

Internal
Concurrent

Manager

Internal Monitor Processes
You can provide fault tolerance for the Internal Concurrent Manager by using
Internal Monitor Processes.
The Internal Concurrent Manager can run on any node and can activate and
deactivate concurrent managers on the same or other nodes. Because the
Internal Concurrent Manager must be active at all times, it needs high fault
tolerance. To provide this fault tolerance, parallel concurrent processing uses
Internal Monitor Processes.
The sole job of an Internal Monitor Process is to monitor the Internal
Concurrent Manager and to restart that manager if it fails. The first Internal
Monitor Process to detect the failure of the Internal Concurrent Manager restarts
the Internal Concurrent Manager on its own node.
Only one Internal Monitor Process can be active on a single node. You decide
which nodes have an Internal Monitor Process when you configure your system.
You can also assign each Internal Monitor Process a primary and secondary
node to ensure its protection.
Internal Monitor Processes, like concurrent managers, can have assigned work
shifts and are activated and deactivated by the Internal Concurrent Manager.
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Log and outputLog and output

filesfiles

Concurrent
manager

Concurrent
manager

Internal 
Monitor
Process

Concurrent
manager

Concurrent
manager

Internal
Concurrent

Manager

Viewing Log and Output Files
You can review log and output files from any node, regardless of which node
the concurrent process runs on. You do not need to log on to a node to view the
log and output files from requests run on that node. The concurrent log and
output files from requests that run on any node are accessible online from any
other node. This capability relies on setup steps taken at install time. For more
information, refer to the installation documentation for your platform.

• INVLIBR: Contains immediate concurrent programs used by Oracle
Inventory.

• MFCLIBR: Contains immediate concurrent programs used by Oracle
Manufacturing.

• PALIBR: Contains immediate concurrent programs used by Oracle
Projects.
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Oracle Enterprise Manager
Oracle Applications has integrated its concurrent manager administrative
interface with Oracle Enterprise Manager, thus enabling administrators to better
manage their systems. Oracle Enterprise Manager provides a single point of
administration for all available Oracle Applications instances on a system.
Oracle Enterprise Manager is a java-based framework consisting of multiple
components that integrate into a powerful graphical user interface (GUI). Oracle
Enterprise Manager combines a central console, agents, common services, and
tools to provide an integrated, comprehensive system management platform for
managing Oracle products.
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• Provides an Applications
DBA-oriented subset of the
current Oracle Applications
System Administration
functions in a new Oracle
Applications console.

• Provides an Applications
DBA-oriented subset of the
current Oracle Applications
System Administration
functions in a new Oracle
Applications console.

• Allows the performance of many tasks for
several Oracle Applications instances from a
single Oracle Applications Manager console.

• Allows the performance of many tasks for
several Oracle Applications instances from a
single Oracle Applications Manager console.
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Management Pack for Oracle
Applications

Extends Oracle Enterprise Manager to enable the
monitoring, diagnosing, and capacity planning of
the multitiered Oracle Applications environment.
Features include:

• Discovery and graphical representation of
services to be monitored.

• Automated data collection and management
services.

• Central monitoring and administration of remote
systems using intelligent agents.

Extends Oracle Enterprise Manager to enable the
monitoring, diagnosing, and capacity planning of
the multitiered Oracle Applications environment.
Features include:

• Discovery and graphical representation of
services to be monitored.

• Automated data collection and management
services.

• Central monitoring and administration of remote
systems using intelligent agents.
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Management Pack for Oracle
Applications

The Oracle
Applications
Manager applet
allows
administrators to
perform all
Concurrent
Manager
administration
tasks from the
Enterprise
Manager console.

The Oracle
Applications
Manager applet
allows
administrators to
perform all
Concurrent
Manager
administration
tasks from the
Enterprise
Manager console.

Applications Manager features the same tree and 
detail view as other Enterprise Manager tools.

Management Pack Tools
Oracle Applications Manager console
The Oracle Enterprise Manager console is extended to discover concurrent
managers and to notify you should any of the servers go down. You can also
define jobs for any of the Oracle Applications subsystems, allowing central
administration of a distributed Oracle Applications system.
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The Management Pack for Oracle
Applications  adds nine Advanced Events to
monitor Concurrent Managers for specific
conditions that may require action.

The Management Pack for Oracle
Applications  adds nine Advanced Events to
monitor Concurrent Managers for specific
conditions that may require action.

Management Pack Tools
Advanced Events
Oracle Applications Advanced Events is a library of events specific to Oracle
Applications provided for lights-out event monitoring and problem detection.
Additional lights-out problem resolution is provided with fix-it jobs that are
configured to run automatically when an event triggers. These fix-it jobs are
either custom-built or chosen from a predefined set provided with the
Management Pack.
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Oracle
Performance
Manager allows
administrators
to monitor
performance
statistics for
Oracle
Applications
Concurrent Managers and
host operating systems. Administrators can
display this data in different chart formats.

Oracle
Performance
Manager allows
administrators
to monitor
performance
statistics for
Oracle
Applications
Concurrent Managers and
host operating systems. Administrators can
display this data in different chart formats.

Management Pack Tools
Oracle Performance Manager
A new Oracle Applications data gatherer cartridge feeds data to Oracle
Performance Manager, providing you with an extensive array of real-time
monitoring charts on all concurrent managers and Forms sessions that are used
by your instance.
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Oracle Capacity
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administrators
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analyze
historical
performance
statistics from
Oracle
Applications
Concurrent Managers and host operating systems
to estimate future capacity requirements.

Oracle Capacity
Planner allows
administrators
to collect and
analyze
historical
performance
statistics from
Oracle
Applications
Concurrent Managers and host operating systems
to estimate future capacity requirements.

Management Pack Tools
Oracle Capacity Planner
Concurrent manager performance data is gathered over time and fed to Oracle
Capacity Planner for analysis of resource consumption and detection of
performance anomalies.
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The Concurrent
Processing
Tuning Assistant
reports historical
information
about Oracle
Concurrent
Managers,
Concurrent
Programs, and Concurrent Processing Requests.

You can use these reports to achieve better
throughput and performance.

The Concurrent
Processing
Tuning Assistant
reports historical
information
about Oracle
Concurrent
Managers,
Concurrent
Programs, and Concurrent Processing Requests.

You can use these reports to achieve better
throughput and performance.

Management Pack Tools
Concurrent Processing Tuning Assistant
Concurrent Processing Tuning Assistant allows you to examine historical
processing information about Oracle concurrent processing requests and
concurrent managers.
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• You should now be able to do the following:
• Change the status of requests when necessary
• Review log files to identify problems
• Manage memory usage of concurrent processing

files and tables
• Balance manager processes over different periods

of time to optimize throughput.

• You should now be able to do the following:
• Change the status of requests when necessary
• Review log files to identify problems
• Manage memory usage of concurrent processing

files and tables
• Balance manager processes over different periods

of time to optimize throughput.

Lesson Summary
In addition to controlling access to Oracle Applications, monitoring the day-to-
day processing of Oracle Applications is a very important job of the system
administrator.
The system administrator is the first point of contact when users have, or
suspect they have, a problem with either the results or the processing of a
request. The system administrator has access to several application log files
containing diagnostic information that can be of use in correcting problems.
The system administrator is also responsible for balancing workload to maintain
optimum performance for users. He or she does this by creating concurrent
managers to process user requests. Managers can be specialized to operate only
during certain times and to process only certain types of requests. System
administrators also monitor and control the activity of managers in a parallel
environment.
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• You should now be able to do the following:
• Specialize managers to read only certain requests
• Restart managers when necessary
• Balance managers across nodes in a parallel

processing environment

• You should now be able to do the following:
• Specialize managers to read only certain requests
• Restart managers when necessary
• Balance managers across nodes in a parallel

processing environment
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Defining a Concurrent Manager Practice
Instructions

Your finance department manager has mentioned to
you that there are several high-volume reports she
needs that are becoming increasingly difficult to
obtain in a timely manner. She has asked if there is
anything you can do so that the reports can be
generated more quickly.  You decide to create a new
concurrent manager to process the reports overnight.

Your finance department manager has mentioned to
you that there are several high-volume reports she
needs that are becoming increasingly difficult to
obtain in a timely manner. She has asked if there is
anything you can do so that the reports can be
generated more quickly.  You decide to create a new
concurrent manager to process the reports overnight.

Instructions
Use your own initials when you see nnn below.

1. Define two work shifts. Call your first work shift nnnDAYSHIFT. This
shift covers the hours from 8:00 am to 5:00 PM Monday through Friday.
Call your second work shift nnnNIGHTSHIFT. This shift should cover
the hours of 5:00 PM until 11:59 am Monday through Friday. Remember
to use military time numbering.

2. Define a new concurrent manager. Use the following definitions:
Manager: nnnCLASSMANAGER
Short Name: Your Company’s Initials Mgr
Application: Your custom application
Description: Your Company’s Name class manager
Type: Concurrent Manager
Program Library: FNDLIBR
Allow all other fields to default.

3. Assign the two work shifts to the manager. Give the manager a larger
number of target processes during the night work shift.

Practice Solutions
Define Your Workshifts
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1. Navigate to (N) Concurrent > Manager > Workshifts.
2. From the menu, select File > New, or click the New icon on the toolbar.
3. Enter the data from the instructions in the appropriate fields in the

window.
4. Continue to add in the appropriate information to define your second work

shift.
5. Click Save to save your work.

Define a Concurrent Manager
6. Navigate to (N) Concurrent > Manager > Define.
7. Enter the data from the instructions in the appropriate fields in the

window.
8. Click Workshifts to display the Work Shifts window.  Assign the work

shifts that you created earlier in this practice by selecting them from the
list of values in the Work Shift column.

9. Enter the number of processes appropriate for your workshifts.
10. Click Save to Save your work.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Define printer types
• Register a printer as a specific printer type
• Assign a print style and printer driver to a printer

type
• Create a custom print style and printer driver
• Create a custom SRW driver

After completing this lesson, you should be able to
do the following:
• Define printer types
• Register a printer as a specific printer type
• Assign a print style and printer driver to a printer

type
• Create a custom print style and printer driver
• Create a custom SRW driver

Lesson Aim
Installing a new printer is a typical responsibility of the system administrator. A
less common need is to customize the software that supports printers. This
lesson shows you how to accomplish both tasks.
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Text formatting
(bold, underline)

Document formatting
(height, width)

Printer formatting
(portrait, landscape)

Formatting Information
For a printer to produce a report, it requires three basic types of formatting
instructions: text, document, and printer.
Text Formatting

• Oracle Reports generates reports for the various Oracle Applications.
• When Oracle Reports formats text as bold or underlined, and sets page

breaks, formatting codes are used.
• A SQL*ReportWriter (SRW) driver defines text formatting codes used by

Oracle Reports.
Document Formatting

• The dimensions for a report output file are predefined as the number of
columns and rows (width and height).

• A print style defines the dimensions for a report output file.
Printer Formatting

• A printer prints in a certain orientation, portrait or landscape.
• A printer can also start printing with a specific font and type size. These

instructions are contained in an initialization string.
• A printer driver defines initialization and reset strings.
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Printer type describes printer.

Printer style formats document.

Printer driver formats output.

SRW driver formats text.

Required Formatting Information for Components
The formatting information required by your printer is specified by the
components shown on this figure.
Printer Type
Describes what kind of a printer you have. This is the manufacturer and
model—for example, a DEC LN03 printer or an HP LaserJet III printer.
Printer Style

• Describes how a report should be printed
• Determines the number of lines (rows) per page
• Determines the width of each line (number of columns)
• Controls whether to print a header page

Printer Driver
• Contains the set of commands that tell a printer how to print in the print

style chosen
• Initializes printing orientation
• Resets printer driver’s instructions for next print job

Printer Drivers Versus SRW
• A printer driver formats the destination printer.
• An SRW driver formats text and sets page breaks in an Oracle Reports

file.
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Print
styles

Printer
drivers

PrintersPrinter
types

Page sizePage size
orientationorientation

CommandsCommands

Reset MakeMake
modelmodel
LN03LN03

Op sys nameOp sys name
HP4FL1HP4FL1

How the Print Components Are Related
Oracle Applications uses the components shown on the previous figure to store
the information necessary to print a report. This figure shows how the
components are related to provide a flexible method of defining your print
environment. The printer type is at the heart of your print definitions. The figure
shows that:

• A printer is registered as a printer type.
• A printer style is associated with a printer type.
• A printer driver is assigned to a printer type.
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Register printer 
as new type

Define new type
(if needed)

Define new style
(if needed)

Define new
driver

Register printer 
as predefined type

Using custom Using custom 
componentscomponents

Using predefined Using predefined 
componentscomponents

How to Define Printers
The figure shows the sequence of operations to define printers. Generally, you
simply register a new printer by using existing definitions as shown in the path
on the left. However, in some cases you must modify existing definitions or
create new definitions to accommodate a new printer as shown on the right.
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• Before you can register a new printer, you need to
decide its type.

• Use the Printer Types form to view existing
combinations of print style and printer drivers to
decide whether an existing printer type supports
your new printer.

• Choose (M) View > Find All to see all the existing
definitions.

• Before you can register a new printer, you need to
decide its type.

• Use the Printer Types form to view existing
combinations of print style and printer drivers to
decide whether an existing printer type supports
your new printer.

• Choose (M) View > Find All to see all the existing
definitions.

Printer Types Window
(N) Install > Printer > Types
For a complete explanation of the fields in this form see:
(Help) Applied Technology > Oracle Applications System Administration >
Printers > Printer Types Window
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• To add a new printer for an existing printer type,
simply register the printer in the Printers
window.

• If you need to define a new printer type, the
Printer Types button opens the appropriate
window.

• To add a new printer for an existing printer type,
simply register the printer in the Printers
window.

• If you need to define a new printer type, the
Printer Types button opens the appropriate
window.

Registering a New Printer
(N) Install > Printer > Register
For a complete explanation of the fields in this form see:
(Help) Applied Technology > Oracle Applications System Administration >
Printers > Printers Window
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Defining a New Printer TypeDefining a New Printer Type

If an appropriate predefined printer type is not listed,
you can define a new type of printer.
If an appropriate predefined printer type is not listed,
you can define a new type of printer.

• Assign a style and a printer driver to print a report
in a specific style.

• The Style and Driver buttons open the appropriate
windows where you can define these items.

• Assign a style and a printer driver to print a report
in a specific style.

• The Style and Driver buttons open the appropriate
windows where you can define these items.

Defining a New Printer Type
(N) Install > Printer > Types
For a complete explanation of the fields in this form see:
(Help) Applied Technology > Oracle Applications System Administration >
Printers > Printer Types Window
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Customizing Printer ComponentsCustomizing Printer Components

Print style

Printer driver

SRW driver

Ways to Customize Printer Components
You can customize your Oracle Applications printing capabilities by:

• Customizing a print style using the Print Styles window
• Customizing a printer driver using the Printer Drivers window
• Creating or modifying an SRW (SQL*ReportWriter) driver using a text

editor
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Customizing Print StylesCustomizing Print Styles

Rows (height)

Columns (width)

Customizing Print Report Rows and Columns
(N) Install > Printer > Style
You can define a custom print style to change the number of columns (width)
and rows (height) for a report.
Style Requirements

• A print style must satisfy the concurrent program’s definition of minimum
and maximum number of columns (width) and rows (height).

• A print style must be assigned to the target printer type.
For a complete explanation of the fields in the Print Styles window see:
(Help) Applied Technology > Oracle Applications System Administration >
Printers > Printer Styles Window
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Customizing Printer DriversCustomizing Printer Drivers

Printer driver

Customizing Printer Drivers
(N) Install > Printer > Driver
Printer drivers are responsible for communicating to the printer the information
necessary to print the report in the style required by the printer style selected.
Create custom printer drivers to support print styles for new or existing printer
types. Here are some other possible situations in which you could need to define
a new printer driver.

• Customize a printer driver when a printer type requires different control
characters.

• Customize a printer driver when the control characters have a different
meaning because of your operating system and platform.

• Customize a printer driver when language translation changes the meaning
of the control characters.

• Customize a printer driver when the printer needs special control
characters to select different character sets.

• Customize a printer driver to change the printer’s default font for a report
(Initialization string only).

Refer to the printer manufacturer’s documentation for the control codes and
escape sequences the printer understands. Refer to the printer’s manual—for
example, a PCL or PostScript manual—for additional information if necessary.
For a complete explanation of the fields in the Printer Drivers window see:
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(Help) Applied Technology > Oracle Applications System Administration >
Printers > Printer Drivers Window
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Invoking a Printer DriverInvoking a Printer Driver

Concurrent
manager

Print
subroutine*

Operating
system

Custom
program*

Operating
system

*Name specified on Printer Driver window*Name specified on Printer Driver window

Print command and arguments

Arguments

 Command

Arguments

Invoking a Printer Driver
There are three methods to invoke a printer driver.
Command

• The concurrent manager issues an operating system print command and its
arguments.

• An operating system print command along with all its arguments is
entered in the Arguments field of the Printer Drivers form.

Program
• The concurrent manager calls a custom print program and passes

arguments to the program.
• The name of a custom print program is entered in the Name field, and any

arguments to be passed to the program are entered in the Arguments field
of the Printer Drivers form.

Subroutine
• The concurrent manager calls a predefined Oracle Applications subroutine

that passes a print command and arguments to the printer via the operating
system.

• A subroutine name appears in the Name field of the Printer Drivers form.
• The Arguments field is disregarded. The concurrent manager reads the

Initialization and Reset escape sequences.
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• On UNIX systems this method, unlike the command method, does not
start an operating system shell along with the print command.
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Passing Print ArgumentsPassing Print Arguments

Destination of target printer

Number of copies to print

Header page title

Name of file to print

Types of Print Arguments Passed
You can rely on a concurrent manager to supply four values as arguments to the
operating system print command it issues or a custom print program that it calls.
Print Arguments

• Destination or target printer
• Number of copies to print
• Name of the file to print
• Title that appears on the header page
• The header page is printed when the Suppress Header Page field is set to

No in the Print Styles window.
Print Commands

• Print commands vary; however, the tokens for which values are retrieved
are always the same.

• Print commands are operating system-dependent. Refer to Installing
Oracle Applications.
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Using the Program Driver MethodUsing the Program Driver Method

Concurrent
manager

Custom
program*

*Name specified on Printer Driver window*Name specified on Printer Driver window

Arguments

Program Driver Method Considerations
(N) Install > Printer > Driver
Location of Custom Print Programs
To call a custom print program by using the Printer Drivers window, enter the
program name, including the full path to the program, in the Program Name
field. The path to the program name is not necessary if the program location can
be identified by the operating system’s PATH environment variable—that is, it
is in the $PATH variable name.
For platforms where the equivalent of a $PATH variable does not exist, use the
full path name. A path can be up to 255 characters.
Custom print programs are not registered as concurrent programs with Oracle
Application Object Library but are called after the concurrent process has
completed.
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Initiating Printing
from a System Shell Script

Initiating Printing
from a System Shell Script

• Use the command
method or the printer
driver method.

• Place the script in the
appropriate directory.

• Use the command
method or the printer
driver method.

• Place the script in the
appropriate directory.

SystemSystem
Shell ScriptShell Script

How to Initiate Printing from a System Shell Script
To initiate printing from an operating system shell script:

• For operating system shell scripts, the printer driver method can be either
Command or Program, as long as you populate the argument field
correctly.

• The script for a command shell procedure—for example, a UNIX shell or
a VMS dcl—should reside in $FND_TOP/$APPLBIN.
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Printing from Standard Input
Directly to the Printer

Printing from Standard Input
Directly to the Printer

• Invoke the printer driver
by using the command
method.

• Select the Standard
Input check box.

• Invoke the printer driver
by using the command
method.

• Select the Standard
Input check box.

Command MethodCommand Method

How to Print from Standard Input
Standard input refers typically to data or commands entered from the keyboard.
It can be from a redirected source such as a file or the output of a program.
Examples of Using Standard Input

• When running a pipe in UNIX such as “cat filename | lpr” rather than just
“lpr filename,” the output file is sent to the stdin (standard input).

• The UNIX print command lpr accepts standard input when a filename is
not specified.

Standard Input Settings
• When you select the Standard Input check box, the printer driver can send

standard input to the printer.
• Clear the Standard Input check box if the driver method is Program or

Subroutine or the operating system print command or print program does
not accept standard input.

• When the Standard Input check box is cleared, the print command issued
by the concurrent manager runs asynchronously. The concurrent manager
issues the command and does not wait for an operating system response.



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing Printers
Chapter 5 - Page 21

Driver Method Parameters for Spooling

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Driver Method Parameters
for Spooling

Driver Method Parameters
for Spooling

Check box cleared Check box selected

Concurrent
manager

Temporary file

Print
program

Temporary file

Setting Spooling Specifications
A spool file contains a copy of a file to be printed and the initialization and reset
strings of the printer driver. Spooling is the process of sending a spool file to the
spooling area of the printer. Spool files are deleted after printing.
Spool File Check Box Selected

• Spool filing specifications are set on the Printer Drivers window in the
Define Method Parameters region. (N) Install > Printer > Driver.

• The Spool File check box is selected only if the print program creates its
own temp file. Selecting the Spool File check box prevents the concurrent
manager from creating its own temp file.

• When you select the Spool File check box, it is recommended that
Initialization and Reset fields are null and the Standard Input check box is
cleared.

Spool File Check Box Cleared
• When the Spool File check box is clear, the concurrent manager makes a

copy of the file to be printed and sends the copy to the spooling area of the
printer.

• Clear the Spool File check box when an operating system print command
or a print program does not make a copy of each file to be printed.
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Initialization and Reset Field ContentsInitialization and Reset Field Contents

• Specified in the Printer Drivers window
• Control print orientation, character set, and line

density
• Nonprintable characters can be specified in octal

• Specified in the Printer Drivers window
• Control print orientation, character set, and line

density
• Nonprintable characters can be specified in octal

When to Use Initialization and Reset Strings
Edit Initialization and Reset strings when a printer type requires different
control characters, escape sequences, or instructions.
Initialization and Reset Strings

• Use the Initialization and Reset fields to set and reset the orientation,
character set, and line density for your printer.

• Initialization and Reset strings consist of control characters and escape
sequences.

• A control character can be represented by a caret (^) followed by another
character.

• An escape sequence can be represented by a slash (/).
Example: Escape Sequence
For nonprintable characters, you can represent their value in octal mode. For
example, represent 0x26 as /046.
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Creating a Custom
SQL*ReportWriter Driver

Creating a Custom
SQL*ReportWriter Driver

1. Copy an existing .prt file and save.
2. Modify the new file with new control information.
3. Place the new file in $FND_TOP/$APPLREP.
4. Assign the new driver to a print style or printer

driver.

1. Copy an existing .prt file and save.
2. Modify the new file with new control information.
3. Place the new file in $FND_TOP/$APPLREP.
4. Assign the new driver to a print style or printer

driver.

Creating a Custom SQL*ReportWriter Driver
Customize Oracle Reports SRW drivers if a printer type does not properly
interpret the control characters that set page breaks, or bold or underlined type
in applications reports.
SRW Drivers

• SRW drivers are read by Oracle Reports when a report is generated and
insert control characters that tell the destination printer where to set page
breaks and which characters to format as bold or underlined.

• SRW drivers are designed for the DEC LN03 printer and all printers that
understand the same control characters as the LN03.

• An SRW driver is used during the generation of a report. A printer driver
is used when the completed output file is sent to the printer.

• SRW driver files reside in $FND_TOP/$APPLREP and have the
extension .prt.

Creating a New SRW Driver
1. Copy an existing SRW Driver (.prt file) and rename the copy before

starting any text editing.
2. Modify the new file with new control characters.
3. Place the modified copy of the SRW driver file in

$FND_TOP/$APPLREP. Oracle Reports will use the new driver if it is
associated with a print style and/or printer driver definition.
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srw driver-A.prt

printer”dec LN03 A4 Landscape”

height 62
width 132

between pages control(L)

return ””
linefeed control(J)

code”bold on” esc”[1m”
code”bold off” esc”[0m”
code”underline on” esc”[4m”
code”underline off” esc”[0m”

Sample SRW Driver File
The slide shows the definition for the A.prt driver file and shows the
information contained in a typical SRW file.
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Order of Reading Printer SettingsOrder of Reading Printer Settings

Printer user profile
 option value

Concurrent programs
definition

Report set 
definition

User submits report
to run

Hierarchy of Printer Assignments
You can restrict concurrent programs and reports to send their output to a
specific printer, or you can provide a default printer.

• At the concurrent program level the system administrator can define a
concurrent program to always direct its output to only one printer. This
setting cannot be overridden by users.

• At the request set level, the system administrator can assign a default
printer for each report in the request set or for the entire request set. If the
request set is unowned, no one can override this setting.

• Also at the request set level, an application user can assign a default
printer to a report within the set or to the entire set. This value can be
overridden by the administrator.

• At the personal profile level, an application user can assign a default
printer for all of his or her reports. This value overrides any other values.

• At the site level, the system administrator can assign a default printer for
all reports. This can be overridden by users.
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Testing Your CustomizationTesting Your Customization

Run reportRun report

Check 
output

New 
printer
driver

Testing Your Customization
You can verify printer driver definitions by printing different styles from each
printer type you are using.
Initialization String

• Print a short report to verify that the page’s printing orientation is correct.
Edit page orientation instructions in the Initialization string.

• If you want to change the printer’s default font for the report, include that
information in the Initialization string.

Reset String
• Print two short reports with different printing orientations to verify that the

printer is resetting itself properly.
• For example, print one report that is landscape and another that is portrait.

Edit printer reset instructions in the Reset string.
Arguments

• Print a short report to verify that the arguments to the operating system’s
print command or custom print program are being interpreted correctly.

• Check that the correct file is being printed at the destination printer and
check the number of copies that are printed. Edit arguments in the
Arguments field.
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You should now be able to do the following:
• Register new printers
• Define new printer types
• Create a custom print style
• Create a custom printer driver
• Assign a print style and printer driver to a printer

type
• Create a custom SRW driver for formatting text

and page breaks

You should now be able to do the following:
• Register new printers
• Define new printer types
• Create a custom print style
• Create a custom printer driver
• Assign a print style and printer driver to a printer

type
• Create a custom SRW driver for formatting text

and page breaks
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• Defining a print style
• Defining a printer driver
• Defining a printer type
• Registering a printer

• Defining a print style
• Defining a printer driver
• Defining a printer type
• Registering a printer

Instructions
Use the information in the following charts as you complete the practice.
Defining a Print Style
Your printer style describes the appearance of your printed pages. This includes
the orientation as well as the number of columns and rows. Use the information
below to define a new print style.

Style Name: nnnS - Printer Style
Sequence Number: your student number  + 300
User Style: Snnn - Portrait
SRW Driver: P-Snnn
Description: (your description)
Layout Columns: 80
Rows: 66
Suppress Header: enabled
Orientation: Portrait

Defining a Printer Driver
Use the information below to define a driver to be associated with your new
print style. This driver specifies the initialization and reset strings as well as
other system related information
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Driver Name: nnnS - Printer Driver
User Driver: Snnn - Portrait
Description: (your description)
SRW Driver: P-Snnn
Platform: Windows - NT
Driver Method: Command
Arguments lp -c -d$PROFILES$.PRINTER -

n$PROFILES$.CONC_COPIES
Initialization: /e[!p
Reset:  /e[!p

Defining a Printer Type
Your printer type definition specifies the allowable printer styles and drivers for
your printer. Use the information below and define all the printer styles and
drivers listed

Type: nnnS - HPLJ5
Description: (your description)
Style: Driver Name:
Snnn - Printer Style  Snnn - Printer Driver
A4 A4PRINTCMDLQ1070
DYNAMIC PORTRAITCMDLQ1070
LANDSCAPE LANDSCAPECDM1070
PORTRAIT PORTRAITCMDLQ1070

Registering Printers
The last step in setting up your printers is to register your new printer with
Oracle Applications and associate a printer type with it. Use the information
below to register two new printers: one using your new printer type and another
that uses an existing printer type.

Printer Type Description
Snnn - Printer - 1 nnnS - Printer Type   uses my new printer type
Snnn - Printer - 2 (existing printer type)  uses an existing printer type

Testing Your Definitions
To test your new printer definitions, navigate to the SRS window and select a
program for execution. Go to the Options window and query up a list of
available printers. Verify that your new printers are listed.

Practice Solutions
Define a Print Style

1. Navigate to (N) Install > Printer > Style.
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2. Enter the data from the instructions in the appropriate fields in the
window.

3. Click Save to save your work.
Define a Printer Driver

4. Navigate to (N) Install > Printer > Driver.
5. Enter the data from the instructions in the appropriate fields in the

window.
6. Click Save to save your work.

Define a Printer Type
7. Navigate to (N) Install > Printer > Types.
8. Enter the data from the instructions in the appropriate fields in the

window.
9. Click Save to save your work.

Register Your Printer.
10. Navigate to (N) Install > Printer > Register.
11. Enter the data from the instructions in the appropriate fields in the

window.
12. Click Save to save your work.

Test That Your New Printer Definitions Are Listed
13. Navigate to (N) Requests > Run.
14. Click OK to submit a single request.
15. Click Copy a Prior Request to show your last request.
16. Click Completion Options and then tab to the printer field and verify that

your new printer shows up in the list of values for that field.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Set profile option values
• Use user profile option settings as defaults for

concurrent program parameters or flexfield
segments

• Identify several typically modified profile options

After completing this lesson, you should be able to
do the following:
• Set profile option values
• Use user profile option settings as defaults for

concurrent program parameters or flexfield
segments

• Identify several typically modified profile options

Lesson Aim
As a system administrator, you control various options in Oracle Applications
that determine how your applications look and feel. These options can also
control how each application operates. This lesson shows you how to specify
these values.



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing Profile Options
Chapter 6 - Page 4

Profile Hierarchy Levels

Copyright   Oracle Corporation,  2000. All rights reserved.
®

 Profile Hierarchy Levels Profile Hierarchy Levels

Site levelSite level

Application levelApplication level

Responsibility levelResponsibility level

User levelUser level

Setting Profile Hierarchy Levels
Setting a user profile affects application users across one of four different
levels.
Site Level   Site-level settings apply to all users at an installation site. To
display the name of your installation site, select About Oracle Applications
from the Help menu.
Application Level   Application-level settings apply to all users of the specified
application. For example, a profile could be set that applies to all Oracle
General Ledger users. Profile options that can be set at the application-level
override options set at the site level.
Responsibility Level   Responsibility-level settings apply to all users currently
signed on under the responsibility. For example, a profile could be set that
applies to all users of the Oracle General Ledger GL budget supervisor
responsibility. Profile options that can be set at the responsibility level override
options set at the site and application levels.
User Level   User-level settings apply to individual users, identified by their
application usernames. For example, a user profile could be set that applies only
to user JDoe. Profile options set at the user level override all other options.
Set of Books  You can further control security by assigning a set of books to a
responsibility, application, or site.
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Personal Profile ValuesPersonal Profile Values

Depending on the responsibility, many users can
change their personal options:
• Navigate to (N) Profile > Personal to see a list of the

Profiles already defined.
• If the User Value field is unprotected, you can

select a value for this profile option from the list of
values or enter a value directly.

Depending on the responsibility, many users can
change their personal options:
• Navigate to (N) Profile > Personal to see a list of the

Profiles already defined.
• If the User Value field is unprotected, you can

select a value for this profile option from the list of
values or enter a value directly.

For further information on using the Personal Profile Values window see:
(Help) Oracle Applications User’s Guide > Profile Options >
Setting Your Personal User Profile
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The system administrator can set profile options at
any level:
• Navigate to (N) Profile > System to see the Find

System Profile Values window.
• You can set a profile value at the user,

responsibility, site, or application level.

The system administrator can set profile options at
any level:
• Navigate to (N) Profile > System to see the Find

System Profile Values window.
• You can set a profile value at the user,

responsibility, site, or application level.
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as Defaults

Using User Profile Values
as Defaults

Window Field

Concurrent
Programs

Request Set

Key Flexfield 
Segments

Descriptive
Flexfield Segments

Parameter Detail region—
Default Type/Default Value

Parameters

Report
Parameters

Segment

Segment

Default Type/Default Value

Validation Information region—
Default Type/Default Value

Form

Validation Information region—
Default Type/Default Value

Default User Profile Values
After profile values have been defined, they can be referenced elsewhere in
Oracle Applications. The figure shows the locations where profile values can be
used to supply default processing values.

• Enter the setting of a profile option as a default value by selecting Profile
as the default type, and then enter the internal name (not end-user name)
of the profile option as the value in the Default Value field.

• Look up the internal name of the profile option in the User Profiles
appendix of the Oracle Applications System Administrator’s Guide.
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Auditing Related Profile OptionsAuditing Related Profile Options

AuditTrail: Activate

Sign-On: Audit Level

Yes/No

None
User
Responsibility
Form 

Option Values

How to Use Profile Options Related to Auditing
These two profile options are used to enable auditing within Oracle
Applications.
AuditTrail: Activate
This option enables auditing of changes to database tables. AuditTrail tracks
which rows in a database table or tables were updated, at what time, and which
user was logged in using the form or forms.
Sign-On: Audit Level
This option identifies the level of detail at which user activity will be audited.

• NONE: The default, resulting in no auditing being performed
• USER level: Sign-on, sign-off, elapsed time for each user
• RESPONSIBILITY: Tracks user-level information as well as the

responsibility that the user selects
• FORMS: Tracks responsibility-level information as well as the forms the

user connects to during the course of a session
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Currency-Related OptionsCurrency-Related Options

Currency: Negative Format <>, -, ( ), [ ]

Currency: Thousands Separator Yes/No

Currency: Positive Format <>, -, ( ), [ ]

Option Value

How to Use Currency-Related Options
The options shown in the figure control the editing of monetary fields.
Currency: Negative Format
This option enables the user to select the indicators for a negative amount.
Currency: Thousands Separator
This option enables the user to request that a comma be inserted appropriately
within a number of a thousand or more.
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Flexfields: AutoSkip

Flexfields: Shorthand Entry
Flexfields: Show Full Value
Flexfields: Validate on Server

Yes/No

Not Enabled
New Entries Only
Query and New Entry
All Entries

Option Value

Yes/No

Yes/No

Flexfields: BiDi Direction Left to Right
Right to Left

Flexfields: LOV Warning Limit Number of Rows to Return
Flexfields: Open Descr Window Yes/No

How to Use Flexfield-Related Options
The options shown on the figure control the behavior of flexfield processing.
AutoSkip
As soon as you enter a valid value into a flexfield segment, AutoSkip
automatically positions your cursor in the next segment.
Shorthand Entry
This option controls the behavior of shorthand entry of flexfields if shorthand
entry has been defined.
Show Full Value
If both shorthand entry and a complete alias have been defined for a flexfield,
and this option is set to no, the complete flexfield window does not open when
the alias is entered. If this option is set to Yes, the window always opens.
Validate on Server
Set this option to Yes to enable server-side validation of key flexfields. This
improves performance when using key flexfields over a wide-area network.
BiDi Direction
This option controls the appearance of the flexfields window in Applications
running in Semitic languages.
LOV Warning Limit
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Sometimes an LOV can take a very long time to run if there is a very significant
amount of data in it. Set this option to the number of rows to be returned before
you are asked to continue retrieving the entire list.
Open Descr Window
This option allows you to control whether a descriptive flexfield window
automatically opens when you navigate to a customized descriptive flexfield.
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RRA: Enabled

RRA: Delete Temporary Files

RRA: Maximum Transfer Size

Option Value

Yes/No

Yes/No

Number 
of bytes

Concurrent: Attach URL Yes/No

RRA: URL Valid URL

How to Control Output Processing at the System Level
The options shown in the figure control output processing at the system level.
RRA: Enabled
Set this user profile to Yes to use the Report Review Agent to access files on
concurrent processing nodes.
RRA: Delete Temporary Files
When users use a custom editor to view a concurrent output or log file, the
Report Review Agent makes a temporary copy of the file on the client. Setting
this option to Yes automatically deletes these files when the user exits Oracle
Applications.
RRA: Maximum Transfer Size
Specify, in bytes, the maximum allowable size of files transferred by the Report
Review Agent. If you enter no value, there is no size limit.
RRA: URL
Specify a URL that points to the CGI script on your WebServer to use the
Report Review Agent to access files on concurrent processing nodes.
Concurrent: Attach URL
When a user submits a request and specifies people to be notified in the
Completion Options region of the Requests window, everyone is sent a
notification when the request is finished. When this option is set to Yes, the
recipients also receive a URL that they can access to see the request results.
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Viewer: Default Font Size 

Viewer: HTML

Viewer: PDF

Viewer: PostScript

c:/path/to/browser

c:/path/to/viewer

Viewer: Text

c:/path/to/viewer

c:/path/to/viewer

Point size value 

Concurrent: URL Lifetime Number of minutes

Option Value

How the User Can Control Request Output
A user can set several options to control request output.  You can specify
different tools to view different output types, as well as different font sizes.  If a
user asks to send request completion notifications to other people, a URL
pointing to request results can be sent.
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Concurrent: Report Access Level

Concurrent: Attach URL

Concurrent: Save Output

Concurrent: Active Request Limit

User/Responsibility

Printer ID

c:/path/to/browser

3

Concurrent: Request Priority 1–99 (default = 50)

Option Value

Concurrent: Sequential Requests Yes/No

How to Use User-Related Profile Options
Concurrent: Report Access Level
This option determines the level of output and log files that are available to a
user for online viewing.
Concurrent: Attach URL
Setting this option to “Yes” causes a URL to be attached to request completion
notifications. When a user submits a request, and specifies people to be notified
in the defining completion options region, a URL is appended to the notification
that enables them to view the request on-line.
Concurrent: Save Output
You can save your request outputs in a file if one is generated. This allows you
to reprint a request.
Concurrent: Active Request Limit
You can limit the number of requests that can be run simultaneously by each
user, or for every user at a site.
Concurrent: Request Priority
This displays the default priority number for your concurrent requests. Priorities
range from 1 (highest) to 99 (lowest). The default is 50.
Concurrent: Sequential Requests
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Setting this option to Yes forces requests to run sequentially in the order in
which they were submitted.
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SummarySummary

You should now be able to do the following:
• Set user profiles as a convenience for your

application users
• Set user profiles to manage application user

activity
• Use user profiles to provide default values for

concurrent program parameters or flexfield
segments

• Identify profile options typically modified by a user

You should now be able to do the following:
• Set user profiles as a convenience for your

application users
• Set user profiles to manage application user

activity
• Use user profiles to provide default values for

concurrent program parameters or flexfield
segments

• Identify profile options typically modified by a user

Lesson Summary
An important function of the system administrator is to control the default
behavior and appearance of Oracle Applications. This is done by specifying
profile values. In this lesson you saw how to display and update profile values.
You also learned how to reference previously defined profile values elsewhere
in Oracle Applications.



Copyright © Oracle Corporation, 2000. All rights reserved.

Managing Profile Options
Chapter 6 - Page 17

Practice Instructions

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Practice InstructionsPractice Instructions

• Accessing profile options at the site and personal
levels

• Modifying profile options

• Accessing profile options at the site and personal
levels

• Modifying profile options

Instructions
In this practice you will deal with profile options at the personal level and
higher. In most cases, you will be only inquiring on existing values, although
you can change the profile option values at the personal level.
Using Profile Options at the Personal Level

1. Query up the profile option Concurrent: Request Priority. Note its value
here: __________________ Try to update the value.

2. Query up the value for Sign-On:Notification option. Change it to Yes.
Sign off and back on, deliberately mistyping your password at least once.
When you finally enter your password correctly you should see a warning
message.

3. Query up the option Viewer: Default Font Size. If there is no value
specified, set it to 10.

4. Query up the option Printer. Use the List of Values to change or add a
value.

5. Query up the option Concurrent: Hold Requests. Change the value to Yes.
6. Navigate to the SRS screen and submit the Active Users program. Open

the Completion Options window and check what default printer value
appears.

7. Submit your program. Note the status and then cancel it.
Using Profile Options at Higher Levels
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There were several profile options mentioned during this lesson. Answer the
following questions by checking the existing values.

1. Which of the following monetary displays matches the current setting of
Currency: Negative Format?
123.45- <123.45> (123.45) [123.45]

2. Is shorthand entry of flexfields enabled?
3. What is the maximum size specified, if any, for transferring output files?

Practice Solutions
Using Profile Options as the Personal Level

1. Navigate to (N) Profile > Personal.
2. Click Find to bring up a list of all profile options.
3. Scroll through the list to find Concurrent: Request Priority. Note that this

option cannot be changed at this level.
4. Select (M) View > Find to open the Find Personal Profile Values window.
5. Type in your query to find the Sign-On:Notification option and click Find.
6. Continue to use the Find Personal Profile Values window to answer the

questions 1-5 listed in the instructions.
7. To submit a program to test these changed options, navigate to the

Requests window.
8. Navigate to (N) Requests > Run.
9. At the Submit Request window, choose the Active Users program from

the list of values.
10. Click Options... in the Upon Completion region of the window and note

the default printer value.
11. Submit your request.
12. Navigate to (N) Requests > View to view your request.
13. The status of your request should be On Hold. Select your request and

click Cancel Request.
Using Profile Options at Higher Levels

1. Navigate to (N) Profile  > System.
2. Use the Find System Profile Values window to find the option

Currency:Negative Format.
3. Select (M) View  > Find to redisplay the Find System Profile Values

window to find the option Flexfields:Shorthand Entry. Note its value.
4. Repeat Step 3 to find the option RRA:Maxmimum Transfer Size and note

its value.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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ObjectivesObjectives

After completing this lesson, you should be able to
do the following:
• Identify different ways of auditing Oracle

Applications performance and resources
• Modify auditing related profile options
• Identify auditing related reports
• Selectively implement auditing as appropriate to

your environment

After completing this lesson, you should be able to
do the following:
• Identify different ways of auditing Oracle

Applications performance and resources
• Modify auditing related profile options
• Identify auditing related reports
• Selectively implement auditing as appropriate to

your environment

Lesson Aim
As system administrator you may audit application users and the changes that
they make to application data. You will learn how both of these options are set
and why you use them.
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Auditing user activity (Sign On Audit)Auditing user activity (Sign On Audit)

Auditing database row changes (AuditTrail)Auditing database row changes (AuditTrail)

Database TableDatabase Table Audit TableAudit Table

Changes to Audit in Oracle Applications
Within Oracle Applications, you can audit user activity and database row
changes.
Sign-On Audit Feature
The Sign-On Audit feature enables you to monitor user activity. You can audit
at the user, responsibility, or form level. When you enable Sign-On Audit, you
specify the desired level of auditing. Sign-On Audit provides two methods for
viewing audit data:

• The Monitor Users form provides online access to audit data.
• Various Sign-On Audit reports are available.

AuditTrail Feature
With the AuditTrail feature you can keep a history of changes to your important
data: what changed, who changed it, and when it changed. With AuditTrail, you
can easily determine how any data row or element obtained its current value.
The audit data is stored in database tables that can be queried by using any
standard Oracle SQL tool.



Copyright © Oracle Corporation, 2000. All rights reserved.

Auditing System Resources
Chapter 7 - Page 5

Auditing User Activity

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Auditing User ActivityAuditing User Activity

Sign On Audit Sign On Audit 
profile optionprofile option

Sign On Audit reportsSign On Audit reports

Monitor Users formMonitor Users form

Sign-On Audit Feature
You can audit and monitor user activity by enabling the Oracle Applications
Sign-On Audit feature. This enables you to track the activity of users signed on
to Oracle Applications. Implement the Sign-On Audit feature by updating the
Sign-On Audit Level system profile.
With Sign-On Audit you can choose whom to audit and what type of user
information to track. You can selectively determine what audit information you
need to match the needs of your organization.
Sign-On Audit Reports
Sign-On Audit reports give you historical, detailed information on what your
users do in your application. You control the data selected for the reports as
well as how the data is presented.
Monitor Users Window
The Monitor Users window gives you online, real-time information about who
is using Oracle Applications and for what purpose.
You can see which users are signed on, which responsibilities, forms
(windows), and terminals they are using, as well as other information.
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Sign On Audit: User

Sign On Audit: Responsibility

Sign On Audit: Form

Sign On Audit: None

Sign-On Audit Levels
The Sign-On Audit profile option enables you to select a level at which to audit
users who sign on to Oracle Applications. The four possible audit levels
increase in functionality and detail of auditing.
None  This value is the default and disables the Sign-On Audit feature.
User  Auditing at the user level tracks who signs on to your system, the times
that users log on and off, and the terminals they use.
Responsibility  Auditing at the responsibility level tracks all the information
tracked at the user level, including the responsibility that the user is using and
how much time the user used the responsibility.
Form  Auditing at the form level tracks all the information tracked at the user
and responsibility levels as well as which forms the user chooses and how long
he or she uses those forms.
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Interaction of Sign On Audit ValuesInteraction of Sign On Audit Values

Sign On Audit: FormsSign On Audit: Forms

Sign On Audit: UserSign On Audit: User

ConsultantConsultant
responsibilityresponsibility
levellevel

ConsultantConsultant
managermanager
levellevel

Sign On Audit: UserSign On Audit: UserSite levelSite level

Specifying the Sign-On Audit Level
You can specify a Sign-On Audit value at multiple profile levels. A value in
effect at a higher level overrides a value at a lower level. For example, assume a
scenario where your business regularly has independent consultants on-site
whose activity you need to document for billing purposes. In such a situation,
you could use the following auditing setup:

• At the site level specify Sign-on Audit: User to implement the minimum
auditing level for all users of Oracle Applications.

• Set up a custom responsibility to be used by your consultants. Set Sign-On
Audit for this responsibility to the responsibility or even the forms level.

• At the user profile level for the manager overseeing the consultants, set
Sign-on Audit back to the user level.
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Sign On Audit ReportsSign On Audit Reports

Sign On Audit Forms Report

Sign On Audit Concurrent Requests Report

Sign On Audit Responsibilities

Sign On Audit Users Report

Sign On Audit Unsuccessful Logins Report

Reports
The Sign-On Audit feature can generate several reports detailing information
gathered by Sign-On Audit. These reports are shown in the figure.

• Sign-On Audit Forms
• Sign-On Audit Users
• Sign-On Audit Responsibilities
• Sign-On Audit Concurrent Requests Report
• Sign-On Audit Unsuccessful Logins Report
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Sign On Audit Forms ReportSign On Audit Forms Report

Sign On Audit Forms Report
Username

Login Name

Terminal Name

Responsibility Name

Form Name

Start Active Time, End Active Time

Using the Sign-On Audit Forms Report
Use the Sign-On Audit Forms Report to view who is navigating to what form
and when. You can use this report to check for bottlenecks in the system. The
report contains the following columns:

• Username: The Oracle Applications username of the user who accessed
the form

• Login Name: The operating system login name of the user who accessed
the form

• Terminal Name: The operating system ID of the terminal from which the
user accessed the form

• Responsibility Name: The name of the responsibility from which the user
accessed (The responsibility is displayed only if you audited the user at the
responsibility or form Sign-On Audit level.)

• Start Active Time/End Active Time: The dates and times when the user
accessed and exited the form (This information is displayed only if you
audited at the form level.)

• Form Name: The name of the form that the user accessed (The form name
is displayed only if you audited the user at the form level.)
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Sign On Audit Concurrent Requests
Report

Sign On Audit Concurrent Requests
Report

Sign On Audit Concurrent Requests Report

Login Name

Request ID

Concurrent Program Name

User Name

Responsibility Name

Form Name

Requested Start Time

Using the Sign-On Concurrent Requests Report
You can use this report to view information about concurrent requests.

• Login Name: The operating system login name of the user who submitted
the concurrent request

• Request ID: The concurrent request ID of the submitted concurrent request
• Concurrent Program Name: The name of the concurrent program that the

user submitted
• User Name: The Oracle Applications username of the user who submitted

the concurrent request
• Responsibility Name: The name of the responsibility from which the user

submitted the concurrent request (The responsibility is displayed only if
you audited the user at the responsibility or form level.)

• Form Name: The name of the form from which the user submitted the
concurrent request. (This information is displayed only if you audited the
user at the form level.)

• Requested Start Time: The date and time when the request started running
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Sign On Audit Responsibilities ReportSign On Audit Responsibilities Report

Sign On Audit Responsibilities Report

Username
Login Name

Terminal Name

Responsibility Name

Start Active Time/ End Active Time

Using the Sign-On Audit Responsibilities Report
You can use this report to view who is selecting what responsibility and when.
The report contains the following columns:

• Username: The Oracle Applications username of the user who selected the
form

• Login Name: The operating system login name of the user who selected
the responsibility

• Terminal Name: The operating system ID of the terminal from which the
user selected the responsibility

• Responsibility Name: The name of the responsibility that the user used
(The responsibility is displayed only if you audited the user at the
responsibility or form level.)

• Start Active Time/End Active Time: The dates and times when the user
selected or exited the responsibility. The start active time and end active
time are displayed only if you audited the user at the responsibility or form
level.
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Sign On Audit Unsuccessful Logins
Report

Sign On Audit Unsuccessful Logins
Report

Sign On Audit Unsuccessful Logins Report

Username

Login Name

Terminal

Attempt Time

Using the Sign-On Audit Unsuccessful Logins Report
You can use this report to view who attempted unsuccessfully to sign on to
Oracle Applications as another user. An unsuccessful login occurs when a
correct username is entered with an incorrect password. The report contains the
following columns:

• Username: The Oracle Application username of the user who
unsuccessfully signed on

• Login Name: The operating system login name of the user who
unsuccessfully tried to sign on

• Terminal: The operating system ID of the terminal from which the user
unsuccessfully tried to sign on

• Attempt Time: The date and time when the user unsuccessfully tried to
sign on
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Sign On Audit Users ReportSign On Audit Users Report

Sign On Audit Users Report

Session Number

User Name
Login Name

Terminal Name

Start Active Time / End Active Time

ORACLE Process

System Process

Using the Sign On Audit Users Report
You can use this report to view who signs on and for how long. The report
contains the following columns:

• Session Number: The Oracle Applications session number uniquely
identifying each application user sign-on

• User Name: The Oracle Applications username of the user who signed on
• Login Name: The operating system login name of the user who signed on
• Terminal Name: The operating system ID of the terminal from which the

user signed on
• Start Active Time/End Active Time: The dates and times when the user

accessed/ exited Oracle Applications (The start active time and end active
time display only if you audited the user at the user Sign-on Audit level.)

• ORACLE Process: The Oracle Process ID used during the user’s sign-on
• System Process: The operating system process ID used during the user’s

sign-on
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Monitor Users WindowMonitor Users Window

Use this window to monitor what your application
users are currently doing:
• Monitor which users are signed on and what

responsibilities, forms, and terminals they are
using.

• Monitor all users, individual users, or only users
of a specific application or responsibility.

Use this window to monitor what your application
users are currently doing:
• Monitor which users are signed on and what

responsibilities, forms, and terminals they are
using.

• Monitor all users, individual users, or only users
of a specific application or responsibility.

Monitor Users Window
(N) Security > User > Monitor
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Auditing Database ChangesAuditing Database Changes

Database TableDatabase Table Audit TableAudit Table

INSERT

UPDATE

DELETE

Auditing Important Data
AuditTrail enables you to keep a history of changes to your important data. You
can track what changed, who changed it, and when it was changed. Using
AuditTrail, you can easily determine how any data row or column obtained its
current value.
When you enter or update data through your forms, you change the underlying
database tables. AuditTrail tracks which rows in the database were updated.
Audit information for each of these changes is stored in audit tables that can
then be queried and reported upon.
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Steps for Setting Up AuditTrailSteps for Setting Up AuditTrail

1. Identify tables and columns to be audited.
2. Create audit group.
3. Specify columns for auditing.
4. Identify Oracle IDs to be audited.
5. Run AuditTrail Update Tables Report.
6. Develop auditing reports.

1. Identify tables and columns to be audited.
2. Create audit group.
3. Specify columns for auditing.
4. Identify Oracle IDs to be audited.
5. Run AuditTrail Update Tables Report.
6. Develop auditing reports.

How to Set Up the AuditTrail
The figure shows the steps involved in implementing AuditTrail. These steps
are covered in the subsequent slides.

• Because there is overhead involved in recording audit information, it is
important to determine which columns of which tables should be audited;
not all changes to all tables need to be tracked.

• After you have identified what to audit, you can begin setting up
AuditTrail definitions. You should select tables for auditing that are
functionally related. Create an Audit Group that contains these related
tables.

• For each of the tables in the audit group, you must define which columns
are to be audited. The primary key columns for these tables are
automatically included.

• Enable auditing of a particular Oracle ID (schema) by defining audit
installations. This enables you to audit across multiple application
installations.

• After your definitions are complete, run the AuditTrail Update Tables
Report program to create your audit tables and enable auditing for your
audit group.

• There are no predefined audit reports. You can use any SQL tool to
retrieve information from your audit tables.
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RA_Customer_TrxRA_Customer_Trx
_Lines_All_Lines_All

AR_Adjustments_AllAR_Adjustments_All

AR_Cash_Receipts_AllAR_Cash_Receipts_All

Determining Columns and Tables to Audit
You should select columns from tables that are functionally related. For
example, if the accounting department wants to audit changes to any customer
transactions involving cash receipts, columns from the Customer Transactions
Lines table, the Cash Receipts table, and the Adjustments table would be good
candidates for auditing.
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Creating an Audit GroupCreating an Audit Group

RA_Customer_TrxRA_Customer_Trx
_Lines_All_Lines_All

AR_Adjustments_AllAR_Adjustments_All

AR_Cash_Receipts_AllAR_Cash_Receipts_All

Receivables Internal ControlReceivables Internal Control

 

Audit Groups
Once you have your tables and columns identified, you should group those
tables into an audit group. In the figure, the three tables mentioned have been
placed together in a Receivables Internal Control audit group.
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AR_Adjustments_AllAR_Adjustments_All AR_Adjustments_All_AAR_Adjustments_All_A

SQL> DESC AR_Adjustments_ALL_A;
NAME NULL? TYPE

AUDIT_TIMESTAMP NOT NULL DATE
AUDIT_TRANSACTION_TYPE NOT NULL VARCHAR2(1)
AUDIT_USER_NAME NOT NULL VARCHAR2(100)
AUDIT_TRUE_NULLS VARCHAR2(250)
PRIMARY KEY NUMBER
CUSTOMER_TRX_ID NUMBER
APPROVED BY NUMBER
CREATED BY NUMBER
ACCTD_AMOUNT NUMBER

What Audit Shadow Tables Identify
For each table being audited, an audit shadow table is created. This table
contains audit processing data such as the transaction type (for instance,
INSERT) and time-stamp data, the primary key columns of the audited table,
and whatever columns are being audited. In the example above, the
CUSTOMER_TRX_ID, APPROVED_BY, CREATED_BY, and
ACCT._AMOUNT of the AR_ADJUSTMENTS_ALL table are being audited
so the shadow table includes these columns as well as the other columns
required by the audit process.
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Shadow Table ViewsShadow Table Views

Shadow_Table_Name_Shadow_Table_Name_AvnAvn Shadow_Table_Name_Shadow_Table_Name_AcnAcn

Shadow_Table_Name_AShadow_Table_Name_A

Basic table viewBasic table view Table changes viewTable changes view

Using Shadow Table Views
Two views are created for a shadow table. These views are called
Shadow_Table_Name_Avn and Shadow_Table_Name_Acn where n is a
number. If the number of columns being audited is very large, multiple views
are created and numbered sequentially. The presentation of the audit table data
is different depending on whether you are querying the AV view or the AC
view. The AC view enables you to reconstruct the value for a row at a given
time while the AV view provides simple access to when a value was changed.
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Use the Audit Tables window to:
• Identify which table you want to audit
• Identify the columns to be audited from that table

Use the Audit Tables window to:
• Identify which table you want to audit
• Identify the columns to be audited from that table

Audit Tables Window
(N) Security > AuditTrail > Tables
For further descriptions of the Audit Tables window see:
(Help) Applied Technology > Oracle Applications System Administration >
User and Data Auditing > Audit Tables Window
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Identifying the Schema to be AuditedIdentifying the Schema to be Audited

You must enable auditing for the schema that owns
the tables identified in your audit group.  Use the
Audit Installations window to specify this information.

You must enable auditing for the schema that owns
the tables identified in your audit group.  Use the
Audit Installations window to specify this information.

1. Navigate to the Audit Installations window:
(N) Security > AuditTrail > Install

2. Enable the check box next to the schema that
you want to audit.

1. Navigate to the Audit Installations window:
(N) Security > AuditTrail > Install

2. Enable the check box next to the schema that
you want to audit.



Copyright © Oracle Corporation, 2000. All rights reserved.

Auditing System Resources
Chapter 7 - Page 23

Enabling Audit Processing

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Enabling Audit ProcessingEnabling Audit Processing

After you have specified all your audit information,
you must run the AuditTrail Update Tables report to
enable audit processing.

After you have specified all your audit information,
you must run the AuditTrail Update Tables report to
enable audit processing.

1. Navigate to the Submit Requests window:
(N) Requests > Run

2. Query up the AuditTrail Update Tables report in
the Submit Request window.

3. Submit the request.

1. Navigate to the Submit Requests window:
(N) Requests > Run

2. Query up the AuditTrail Update Tables report in
the Submit Request window.

3. Submit the request.



Copyright © Oracle Corporation, 2000. All rights reserved.

Auditing System Resources
Chapter 7 - Page 24

Summary

Copyright   Oracle Corporation,  2000. All rights reserved.
®

SummarySummary

You should now be able to do the following:
• Identify different ways of auditing Oracle

Applications performance and resources
• Modify auditing-related profile options
• Identify auditing-related reports
• Selectively implement auditing as appropriate to

your environment

You should now be able to do the following:
• Identify different ways of auditing Oracle

Applications performance and resources
• Modify auditing-related profile options
• Identify auditing-related reports
• Selectively implement auditing as appropriate to

your environment
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• Using Sign-On Audit reports
• Using the Monitor Users window
• Using Sign-On Audit reports
• Using the Monitor Users window

Instructions
In this practice you will use a signon audit report to determine who was running
a program, who was using a responsibility, and who was using an APPLSYS
process. You will monitor a user by using the Monitor Users window.
Using Signon Audit Reports

• Run the appropriate reports to determine the following:
• Who is running the program FNDCPCRQ?
• Who was using the AP Manager’s responsibility yesterday from 12:00

until 5:00?
• Who is using the Oracle process APPLSYS?

Using the Monitor Users Window
• Navigate to the Monitor Users window.
• Note any activity.
• Query up the Sign-On Audit Level profile option at the user level for your

specific signon. Change it to FORM and save your change.
• Sign off and back on.
• Navigate to the Monitor Users window and note your signon information.

Practice Solutions
Using Sign-On Audit Reports
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1. Navigate to (N) Requests > Run.
2. Click OK to accept the default to submit a single request.
3. Click the List of Values icon to get a list of all reports available for you to

run.
4. Run the following reports to answer the questions in the instructions.
5. Signon Audit Concurrent Requests
6. Signon Audit Responsibilities
7. Signon Audit Users

Using the Monitor Users Window
8. Navigate to the Monitor Users window (N) Security > User > Monitor.
9. Query up your User Name and note the activity.
10. Navigate to the Find System Profile Values window (N) Profile > System.
11. Find the Sign-On Audit Level profile option at the user level for your

specific signon. Change it to FORM.
12. Click Save to save your work.
13. Sign off and on again. (M) File > Log on as a Different User...
14. Navigate to the Monitor Users window again. (N) Security > User >

Monitor.
15. Review the changes of the data in the form.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Identify an executable to Oracle Applications
• Define a concurrent program
• Specify concurrent program parameter information

After completing this lesson, you should be able to
do the following:
• Identify an executable to Oracle Applications
• Define a concurrent program
• Specify concurrent program parameter information

Lesson Aim
Oracle Applications uses concurrent programs to process and report on data
stored in Oracle Applications tables. These programs are secured, processed,
and managed within the Oracle Applications environment, using the operations
that you have seen in other lessons. However, you can take your custom
applications and programs and integrate them into the Oracle Applications
environment as well. In that environment they can be secured and managed the
same way as regular Oracle Applications programs.
This lesson covers how to integrate user-developed programs into Oracle
Applications.
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Using Custom Programs in Oracle
Applications

Oracle ApplicationsOracle Applications

Accounts
Receivable User programUser programSalesSales

Integrating Custom Programs with Oracle Applications
Although Oracle Applications provides you with a complete range of
functionality, you may need to develop and implement your own custom
programs to perform specialized processing. You can integrate such custom
applications into the Oracle Applications environment so that they are processed
like all your other Oracle Applications programs and reports.
For example, a sales table used by Oracle Receivables can also be accessed by a
user program for special reporting needs. Such a user reporting program can be
added to the Oracle Applications environment.
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Assumptions for Incorporating a New
Program

• The program has been completed
• The program parameters have been documented
• Any value sets needed already exist
• Tokens for Oracle Reports are defined

• The program has been completed
• The program parameters have been documented
• Any value sets needed already exist
• Tokens for Oracle Reports are defined
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Input ParametersInput Parameters

Executable

Concurrent program

code

Custom application

Components of a Concurrent Program
You need to define several components of a concurrent program when adding
your custom program to the Oracle Applications environment. A concurrent
program consists of an executable module—for example, an Oracle Reports
program or a PL/ SQL procedure—and the input parameters required by the
program or procedure. A concurrent program must be associated with either an
existing Oracle application or a custom application. In most cases, you will
associate any custom concurrent programs with a registered custom application.
This protects your concurrent programs during an upgrade.
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1. Develop the program or report.
2. Identify the program as an executable and register

it with an application.
3. Create a concurrent program containing the

executable and its parameters.
4. Add the concurrent program to a request group or

set for processing.

1. Develop the program or report.
2. Identify the program as an executable and register

it with an application.
3. Create a concurrent program containing the

executable and its parameters.
4. Add the concurrent program to a request group or

set for processing.

Adding a Custom Program to Oracle
Applications

Adding a Custom Program to Oracle
Applications
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• The first step in adding a custom program to
Oracle Applications is to identify the program or
report as an executable.

• Use the Concurrent Program Executable window
to identify your executable to Oracle Applications.

• The first step in adding a custom program to
Oracle Applications is to identify the program or
report as an executable.

• Use the Concurrent Program Executable window
to identify your executable to Oracle Applications.

Identifying the Executable
(N) Concurrent > Program > Executable
For a complete description of the fields in this window see:
(Help) Applied Technology > Oracle Applications System Administration >
Concurrent Program Executable Window
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• Use the Concurrent Programs window to define
the details about your concurrent program.

• Use the Concurrent Programs Parameters window
to enter and update the program parameters that
you want to pass to the program executable.
The program parameters defined here should
match the variables in your executable.

• Use the Concurrent Programs window to define
the details about your concurrent program.

• Use the Concurrent Programs Parameters window
to enter and update the program parameters that
you want to pass to the program executable.
The program parameters defined here should
match the variables in your executable.

Concurrent Programs Window
(N) Concurrent > Program > Define
For a complete description of the fields in this form see
(Help) Applied Technology > Oracle Applications System Administration >
Concurrent Programs Window

Concurrent Programs Parameters Window
(N) Concurrent > Program > Define > (B) Parameters
For a complete description of the fields in this window see
(Help) Applied Technology > Oracle Applications System Administration >
Concurrent Programs Window > Concurrent Program Parameters Window
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Group

Associating a Program with a Request
Group

• For a concurrent program to be accessible and
eligible for submission, you must define it to a
request group.

• Use the Request Groups window to assign to
qualify your program.

• For a concurrent program to be accessible and
eligible for submission, you must define it to a
request group.

• Use the Request Groups window to assign to
qualify your program.

Associate a Program with a Request Group
(N) Security > Responsibility > Request
For the definition of the fields in this window see
(Help) Applied Technology > Oracle Applications System Administration >
Request Group Window
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Use the Standard Request Submission window to
execute the program:

(N) Requests > Run

Use the Standard Request Submission window to
execute the program:

(N) Requests > Run
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You should now be able to:
• Identify an executable to Oracle Applications
• Define a concurrent program
• Specify concurrent program parameter information

You should now be able to:
• Identify an executable to Oracle Applications
• Define a concurrent program
• Specify concurrent program parameter information
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• Identifying an executable to Oracle Applications
• Creating a concurrent program
• Defining program parameters
• Testing a concurrent program definition

• Identifying an executable to Oracle Applications
• Creating a concurrent program
• Defining program parameters
• Testing a concurrent program definition

Instructions
In this practice you will incorporate a program into Oracle Applications. You
will not actually create a new program but will use an existing Oracle
Applications reporting program instead. This is the Completed Concurrent
Requests Report.
Identifying the Executable
Your first task is to identify the executable to Oracle Applications. Navigate to
the Concurrent Program Executable window and use the data below to fill out
the window.

Executable: nnnS_Completed Concurrent Requests
Short Name: nnnS_CCR
Application: nnnS_Custom_App
Description: your description
Execution Method: Oracle Reports
Execution File Name: FNDCPCRQ

Defining the Concurrent Program
After you have created your executable, you need to create a concurrent
program to contain it. Use the data below to complete the Concurrent Programs
window.
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Program: nnnS_Conc_Req
Short Name: nnnS_CRQ
Application: Custom Application
Description: your description
Executable Name: nnnS_CCR
Columns: 132
Rows: 45
Style: Landscape

Specifying the Program Parameters
After you have created the concurrent program, you need to specify all the
parameters needed by the program. Use the data in the following charts to
define all the parameter information needed. Let any fields not referenced in the
directions simply default.
Note: Be careful when specifying the token name.

Parameter 1:
Field Entry
Sequence: 1
Parameter: Program Application Name
Value Set: Application_Name_to_Shortname
Default Type:
Display Size 50
Description Size: 50
Concatenated Description Size 25
Prompt: Program Application Name
Token: P_Appl_Short_Name

Parameter 2:
Field Entry
Sequence: 2
Parameter: Program Name
Value Set: CONC-Program Name
Default Type:
Display Size 50
Description Size: 50
Concatenated Description Size 25
Prompt: Program Name
Token: P_Program_Name
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Parameter 3:
Field Entry
Sequence: 3
Parameter: User Name
Value Set: AP_SRS_USER_NAME
Default Type:
Display Size 50
Description Size: 50
Concatenated Description Size 25
Prompt: User Name
Token: P_User_Name

Parameter 4:
Field Entry
Sequence: 4
Parameter: Start Date
Value Set: CST_SRS_FROM_DATE
Default Type:
Display Size 9
Description Size: 50
Concatenated Description Size 25
Prompt: Start Date
Token: P_Startdate

Parameter 5:
Field Entry
Sequence: 5
Parameter: End Date
Value Set: CST_SRS_TO_DATE
Default Type:
Display Size 9
Description Size: 50
Concatenated Description Size 25
Prompt: End Date
Token: P_Enddate

Testing Your New Program
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To test your incorporation of a new concurrent program, create a new request
set containing only the new concurrent program. Navigate to the SRS window
and execute the request set. You should be prompted for parameter values, and
your report should run successfully.

Practice Solutions
Identifying the Executable

1. Navigate to (N) Concurrent > Program > Executable.
2. Enter the data from the instructions into the appropriate fields on the

window.
3. Click Save to save your work.

Defining the Concurrent Program
4. Navigate to (N) Concurrent > Program > Define.
5. Enter the data from the instructions into the appropriate fields on the

window.
Specifying the Program Parameters

6. Click Parameters to fill in the appropriate parameter information listed in
the instructions. In the Value Set field, use the list of values to find the
appropriate entry.

7. Continue filling in the parameters as listed in the instructions.
8. Click Save to save your work.

Test your new program
9. Navigate to (N) Requests > Set.
10. Create a request set containing only the new concurrent program that you

created in Step 5. Use the Request Set Wizard to enter the appropriate
information.

11. Navigate to (N) Requests > Run
12. Execute the request set and watch your report run successfully.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Define resource consumer groups
• Assign users, concurrent managers, and

concurrent programs to a resource consumer
group

• Run CBO statistics-gathering reports
• Use the Network Test window to evaluate your

network’s performance

After completing this lesson, you should be able to
do the following:
• Define resource consumer groups
• Assign users, concurrent managers, and

concurrent programs to a resource consumer
group

• Run CBO statistics-gathering reports
• Use the Network Test window to evaluate your

network’s performance

Lesson Topics
The administration of Oracle Applications includes some duties that can fall to
either the Database Administrator or the System Administrator to perform. This
lesson describes several security tasks from different functional areas, which
encompass forms from various locations on the System Administrator menu
tree. These tasks are referred to as Applications DBA duties.
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Resource Consumer Groups Have Similar
CPU Usage Requirements

Users Concurrent 
Programs

Concurrent 
Managers

Resource Consumer Groups: Definition
Resource consumer groups and resource plans are tools used to allocate and
manage resources among database users and applications. The database
administrator establishes resource consumer groups to define users, concurrent
managers, or concurrent programs that have similar CPU usage requirements.
An overall resource plan is used to specify how resources are distributed among
the different resource consumer groups.
System Administrator Assigns Resource Consumer Groups
Oracle Applications allows the system administrator to assign users, concurrent
managers, and concurrent programs to existing resource consumer groups.
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UsersUsers

Concurrent ProgramsConcurrent Programs

Concurrent ManagersConcurrent Managers

(N) Profile > System > (Check box) User(N) Profile > System > (Check box) User

(N) Concurrent > Program > Define >
(B) Session Control
(N) Concurrent > Program > Define >
(B) Session Control

(N) Concurrent > Manager > Define(N) Concurrent > Manager > Define

Assign a User
(N) Profile >System > (Check box) User
The system administrator can assign a user to a resource consumer group by
setting the value of the user profile option FND:Resource Consumer Group for
that particular user. The user can see this profile option but cannot update it.
Assign a Concurrent Program
(N) Concurrent > Program > Define > (B) Session Control
The system administrator can assign a concurrent program to a resource
consumer group in the Session Control window of the Concurrent Programs
form.
Assign a Concurrent Manager
(N) Concurrent > Manager > Define
The system administrator can assign a concurrent manager to a resource
consumer group in the Concurrent Managers form.
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ConcurrentConcurrent
ProgramProgram

TransactionTransaction
ManagerManager

User Running aUser Running a
FormForm

Concurrent
Manager

Program

Profile option
of submitting

User

Default_Consumer_
Group

Transaction
Manager

Program

Default_Consumer_
Group

Default_Consumer_
Group

User
Profile Option

Hierarchy of Resource Consumer Groups
Conflicts can arise between the resource consumer groups associated with a
single session. Oracle Applications uses a hierarchy to resolve these conflicts.
Concurrent Manager Running a Concurrent Program
When a concurrent program is submitted the system first checks for the resource
consumer group assigned to the program. If none is assigned, the system will
use the group assigned to the manager. If none is assigned to the manager, the
system will use the default: Default_Consumer_Group.
User Performing a Transaction
When a user performs a transaction, the system first checks the group assigned
to the transaction. If none is assigned, the system checks the transaction
manager. If the manager is not assigned to a group, the system checks the user’s
profile option. If the user does not belong to a group, then the system uses the
Default_Consumer_Group.
User Running a Form
When a user runs a form, the system first checks the user’s profile option. If the
user is not assigned to a group, the system uses the Default_Consumer_Group.
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Oracle Applications uses
cost-based optimization
(CBO) to choose the most
efficient way to execute SQL
statements.

Oracle Applications uses
cost-based optimization
(CBO) to choose the most
efficient way to execute SQL
statements.

PathsPaths

OptimizerOptimizer

StatisticsStatistics

The optimizer determines the
most efficient execution plan
by considering available
access paths and factoring
information based on
statistics for the schema
objects’ SQL statement.

The optimizer determines the
most efficient execution plan
by considering available
access paths and factoring
information based on
statistics for the schema
objects’ SQL statement.
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To use cost-based optimization effectively, you
must keep your database statistics current.
Oracle Applications provides a set of concurrent
programs to help you collect these statistics:

• Gather Table Statistics
• Backup Table Statistics
• Restore Table Statistics
• Gather Schema Statistics
• Gather Column Statistics
• Gather All Column Statistics
• Analyze All Index Column Statistics

To use cost-based optimization effectively, you
must keep your database statistics current.
Oracle Applications provides a set of concurrent
programs to help you collect these statistics:

• Gather Table Statistics
• Backup Table Statistics
• Restore Table Statistics
• Gather Schema Statistics
• Gather Column Statistics
• Gather All Column Statistics
• Analyze All Index Column Statistics

For further information on these reports see
(Help) Applied Technology > Oracle Applications System Administration >
Cost-based Optimization > Concurrent Programs for CBO
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Use the Network Test window to evaluate the
performance of your network with Oracle
Applications.

Use the Network Test window to evaluate the
performance of your network with Oracle
Applications.

The window provides the following tests:
• Latency Test - examines the time it takes for a

single packet to make a round trip from your client
side application to the server.

• Bandwidth Test - examines the data rate to see
how many bytes per second your network can
transfer from the server to the client.

The window provides the following tests:
• Latency Test - examines the time it takes for a

single packet to make a round trip from your client
side application to the server.

• Bandwidth Test - examines the data rate to see
how many bytes per second your network can
transfer from the server to the client.
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Running Network Tests
(N) Application > Network Test
To Test Latency

• Specify the number of Trials and the Iterations for each trial.
• For each iteration, a single packet is sent from the client application to the

server and back. A trial consists of the specified number of iterations. The
total time for all round trips in a trial is divided by the number of iterations
to obtain their average latency.

• The default settings are 5 trials of 100 iterations each. Select the Run Test
button to perform the test.

To Test Bandwidth
• Specify the number of Trials and the iterations for each trial. For each

iteration, several kilobytes of data are sent from the client to the server and
back. The form measures the average rate at which the data travels.

• The default settings are 5 trials of 10 iterations each.
• Select the Run Test button to perform the test.
• Use the Clear Old Test Data button to purge previous test results from

your database.
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You should now be able to do the following:
• Define resource consumer groups
• Assign users, concurrent managers, and

concurrent programs to a resource consumer
group

• Use the Network Test window to evaluate your
network’s performance

You should now be able to do the following:
• Define resource consumer groups
• Assign users, concurrent managers, and

concurrent programs to a resource consumer
group

• Use the Network Test window to evaluate your
network’s performance
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Assigning Resource Consumer Groups
Example

This example demonstrates how to assign a resource
consumer group to a user and to a concurrent
program.

This example demonstrates how to assign a resource
consumer group to a user and to a concurrent
program.

Assigning Resource Consumer Groups Example
Assign a User to the DEFAULT_CONSUMER_GROUP Resource
Consumer Group

1. Navigate to the System Profile Values find window: (N) Profile > System.
2. Check the User check box and select your user from the list of values.
3. Select “FND: Resource Consumer Group” from the Profile list of values

and click Find.
4. The System Profile Values window will display.  Select

“DEFAULT_CONSUMER_GROUP” from the list of values under the
User column.  Click Save to save your work.

Assign a Concurrent Program to a Resource Consumer Group
1. Navigate to the Concurrent Programs window: (N) Concurrent > Program

> Define.
2. Find your program.
3. Click the Session Control button.
4. Use the list of values to select the consumer group to which you wish to

assign the program.
5. Click Save to save your work.
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Why is it important to keep your database statistics
current?
Why is it important to keep your database statistics
current?
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Why is it important to keep your database statistics
current?

– Because the cost-based approach relies on
your database statistics to accurately
calculate the most efficient execution plan
for SQL statements.

Why is it important to keep your database statistics
current?

– Because the cost-based approach relies on
your database statistics to accurately
calculate the most efficient execution plan
for SQL statements.
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Using the Network Test Window Review
Questions

Review Questions:
1. The __________ Test examines how long it takes

for a packet of information to make a round trip
from the client application to the server.

2. The __________ Test examines data rate to see
how many bytes per second your network can
transfer from the server to the client.

Review Questions:
1. The __________ Test examines how long it takes

for a packet of information to make a round trip
from the client application to the server.

2. The __________ Test examines data rate to see
how many bytes per second your network can
transfer from the server to the client.
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Using the Network Test Window Review
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Review Questions:
1. The __________ Test examines how long it takes

for a packet of information to make a round trip
from the client application to the server.

– Latency

2. The __________ Test examines data rate to see
how many bytes per second your network can
transfer from the server to the client.

– Bandwidth

Review Questions:
1. The __________ Test examines how long it takes

for a packet of information to make a round trip
from the client application to the server.

– Latency

2. The __________ Test examines data rate to see
how many bytes per second your network can
transfer from the server to the client.

– Bandwidth
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Download and upload help files
• Use Oracle Applications special link syntax to link

your help files
• Use the Help Builder to customize Help Navigation

Trees

After completing this lesson, you should be able to
do the following:
• Download and upload help files
• Use Oracle Applications special link syntax to link

your help files
• Use the Help Builder to customize Help Navigation

Trees

Lesson Aim
Oracle Applications uses an extensive network of help files to give users
immediate online assistance. You can customize these help files by
manipulating the files supplied by Oracle, or by adding your own to the system.
This lesson covers how to integrate customized help files into Oracle
Applications.
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Customizing your Oracle Applications help files
includes the following topics:
Customizing your Oracle Applications help files
includes the following topics:

• Downloading help files
• Linking help files
• Uploading help files
• Updating the search index
• Customizing the navigation tree

• Downloading help files
• Linking help files
• Uploading help files
• Updating the search index
• Customizing the navigation tree

Overview of Customizing Help Files
In order to customize help files you first must download them into an area for
manipulation. Oracle Applications help files are in HTML format, making them
easy to modify using a commercial web browser/editor such as Netscape
Communicator. You can also add HTML and GIF files of your own.
Oracle Applications help files use a special link syntax that points the links to
anchors within files rather than to the files themselves. This method ensures that
hypertext links will not be broken if files are renamed or split. This lesson
explains how to use this syntax, although it is not required for your custom help
files.
When your changes are complete, upload the files back to the appropriate
Oracle Applications directory and rebuild the Search index.
Use the Help Builder applet to update the navigation tree with your new files.
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Downloading Help FilesDownloading Help Files

1. Open the file with your browser.

2. Save the file as HTML.

1. Open the file with your browser.

2. Save the file as HTML.

Server
®

Downloading a File
To download a file, open it in you web browser and save it as an HTML file.
If an @ sign is the first character of the file name, remove it.
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Linking Help FilesLinking Help Files

Help files can include links within files, across files,
across application files, and to related topics.
This section includes the following topics:

Help files can include links within files, across files,
across application files, and to related topics.
This section includes the following topics:

• Oracle Applications’ special link syntax overview
– Special link syntax versus conventional HTML
– Using the syntax across files
– Using the syntax across applications

• Links to Related Topics

• Oracle Applications’ special link syntax overview
– Special link syntax versus conventional HTML
– Using the syntax across files
– Using the syntax across applications

• Links to Related Topics
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Oracle Applications’ help files
use a special link syntax that
dynamically resolves links across
files and applications.

Oracle Applications’ help files
use a special link syntax that
dynamically resolves links across
files and applications.

Link 1Link 1
Link 2Link 2

Link 3Link 3

Anchor 1Anchor 1
Anchor 2Anchor 2

Anchor 3Anchor 3

Links point at a named anchor in a file rather
than the filename itself.
Links point at a named anchor in a file rather
than the filename itself.

Oracle Applications Special Link Syntax: Overview
The Oracle Applications help system supports a special syntax for hypertext links that
keeps them working even when files are renamed or split into parts.
Links in Oracle Applications help files point at a named anchor contained in the file
rather than the filename itself. The help system resolves the anchorname to file link
dynamically, every time a link is negotiated.
Information on which files contain which anchornames is put into the help system
automatically on upload. Authors must ensure that anchornames are unique across an
application’s help files to prevent duplicate links.
It is not required that you use Oracle’s special syntax for your custom help files. If you
prefer, you can always use conventional hypertext links based on filename.
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Special Syntax versus Conventional
HTML

Special Syntax versus Conventional
HTML

Conventional HTML:
For more about widgets, see

<AHREF=“#widgets”>All About Widgets</A>
below.

Special Syntax:
For more about widgets, see

<AHREF=“@widgets#widgets”>All About
Widgets</A> below.

Conventional HTML:
For more about widgets, see

<AHREF=“#widgets”>All About Widgets</A>
below.

Special Syntax:
For more about widgets, see

<AHREF=“@widgets#widgets”>All About
Widgets</A> below.

Using the Special Syntax
The conventional HTML example would allow the user to jump forward to a section
with the anchorname “widgets.”
Oracle Applications help files extend this HTML syntax to create links not only within,
but also between help files.
To link to a file that contains a particular named anchor, you simply place an “@”
before the anchorname. To link to the precise spot within the file where the anchor
appears, you append a pound sign followed by the anchorname, just as you would in
conventional HTML.
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General Syntax:
<AHREF=“../shortname/@anchorname#anchorname”>li
nk text</A>

Example:
Use the following link to jump to “All About Widgets”
in the Oracle Payables help directory from another
application help directory:
For more about widgets in Oracle Payables, see
<AHREF=“../AP/@widgets#widgets”>All About
Widgets</A>.

General Syntax:
<AHREF=“../shortname/@anchorname#anchorname”>li
nk text</A>

Example:
Use the following link to jump to “All About Widgets”
in the Oracle Payables help directory from another
application help directory:
For more about widgets in Oracle Payables, see
<AHREF=“../AP/@widgets#widgets”>All About
Widgets</A>.

Using the Special Links Syntax Across Applications
In the Oracle Applications help system, all help files associated with a particular
application exist in the same directory, as far as their URL is concerned. Help files
associated with other applications exist in directories named after the application’s
short name. All these application directories are at the same level in the help system.
To create a link that goes to a help file associated with a different application, you
create a relative link that goes up a level to the parent of all help application directories,
and then back down through the other application’s directory, before concluding with
Oracle Applications’ special link syntax.
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Related Topics LinksRelated Topics Links

Related Topics links offer
access to pages related to the

current help topic.

Related Topics links offer
access to pages related to the

current help topic.

Related Topics Links
When a user negotiates a Related Topics link, a page headed “Related Topics” appears
containing a list of the related page links.
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Related Topics Links SyntaxRelated Topics Links Syntax

Use the following syntax to create a Related Topics
link:
<AHREF=“@anchorname1,anchorname2,anchorname3”>R
elated Topics</A>

To include cross-application links, simply prefix the
application short name and a colon to the
anchorname:
<AHREF=“@anchorname1,shortname:anchorname2,anch
orname3”>Related Topics</A>

Use the following syntax to create a Related Topics
link:
<AHREF=“@anchorname1,anchorname2,anchorname3”>R
elated Topics</A>

To include cross-application links, simply prefix the
application short name and a colon to the
anchorname:
<AHREF=“@anchorname1,shortname:anchorname2,anch
orname3”>Related Topics</A>
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Uploading Your New or Changed Help
Files

Uploading Your New or Changed Help
Files

Oracle Applications supplies a
command-line utility named
FNDGFU for uploading new or
changed help files.

Oracle Applications supplies a
command-line utility named
FNDGFU for uploading new or
changed help files.

Server
®

The FNDGFU utility
FNDGFU is located in the $FND_TOP/bin directory. Putting this directory on your
path will allow you to invoke FNDGFU easily.
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Uploading New or Changed Help FilesUploading New or Changed Help Files

The FNDGFU utility takes the following arguments
for uploading help files:

FNDGFU <apps/pwd> 0 Y

PROGRAM_NAME=FND_HELP

PROGRAM_TAG=<application>:<custom_level>

CONTENT_TYPE=<mime_type>

LANGUAGE=<language_code> <filenames>

The FNDGFU utility takes the following arguments
for uploading help files:

FNDGFU <apps/pwd> 0 Y

PROGRAM_NAME=FND_HELP

PROGRAM_TAG=<application>:<custom_level>

CONTENT_TYPE=<mime_type>

LANGUAGE=<language_code> <filenames>

Using FNDGFU
The components of the argument are:

<apps/pwd> is the APPS schema username/password.
<application> is the application short name.
<custom_level> is the files’ customization level. Use the number 

100 or above for customized help files.
<mime_type> is the files’ MIME type.
<language_code> is the files’ language code.
<filenames> is a space-separated list of files to upload or a 

filename glob in the current directory.
Enter all arguments on a single command line.
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Example Upload Using FNDGFUExample Upload Using FNDGFU

FNDGFU apps/apps@devdb 0 Y

PROGRAM_NAME=FND_HELP

PROGRAM_TAG=GL:100

CONTENT_TYPE=text/html

LANGUAGE=US *.htm

FNDGFU apps/apps@devdb 0 Y

PROGRAM_NAME=FND_HELP

PROGRAM_TAG=GL:100

CONTENT_TYPE=text/html

LANGUAGE=US *.htm

Uploading a File: Example
• Connects to apps/apps@devdb
• Identifies uploaded files as part of Oracle General Ledger (GL) help
• Identifies the uploaded files’ customization level as 100
• Identifies their MIME type as text/html
• Identifies their language as US English (US)
• Uploads all .htm files in the current directory (in UNIX)
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Updating the Search IndexUpdating the Search Index

Run the aflobbod.sql script to rebuild the search
index after uploading your custom help files:

sqlplus <apps/pwd> @$FND_TOP/sql/aflobbld.sql

Run the aflobbod.sql script to rebuild the search
index after uploading your custom help files:

sqlplus <apps/pwd> @$FND_TOP/sql/aflobbld.sql

Rebuilding the Search Index
Oracle interMedia Text enables the search feature provided by the Oracle Applications
help system. Rebuilding the search index ensures that your custom files will be
included in any searches your users perform.
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Customizing Help Navigation TreesCustomizing Help Navigation Trees

Use the Help Builder applet to customize the help
navigation trees.
Trees are composed of a root, nodes, and
documents:
• Root - is the top-most level.  When expanded, it

reveals a collection of first-level nodes and
documents under it.

• Node- expands to reveal nodes and documents
the next level down.

• Document - expands no further, but simply links
to a document, terminating the hierarchy.

Use the Help Builder applet to customize the help
navigation trees.
Trees are composed of a root, nodes, and
documents:
• Root - is the top-most level.  When expanded, it

reveals a collection of first-level nodes and
documents under it.

• Node- expands to reveal nodes and documents
the next level down.

• Document - expands no further, but simply links
to a document, terminating the hierarchy.
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Help Builder FunctionsHelp Builder Functions

Use the Help Builder to perform the following tasks:
• Open a tree for editing
• Add new help files to a tree
• Add new nodes to a tree
• Add nodes from one tree to another
• Change the organization of a tree
• Create a new navigation tree
To access the Help Builder navigate to:
OSSWA > System Administration > Help Builder

Use the Help Builder to perform the following tasks:
• Open a tree for editing
• Add new help files to a tree
• Add new nodes to a tree
• Add nodes from one tree to another
• Change the organization of a tree
• Create a new navigation tree
To access the Help Builder navigate to:
OSSWA > System Administration > Help Builder
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Opening a Tree for EditingOpening a Tree for Editing

1. Enter information on the tree in the Find Trees
window, and click Find.
For example, enter %Payables% in the Prompt field
to find the Oracle Payables tree.

2. Double-click the line in the Trees tab of the main
Help Builder window that most closely
corresponds to the tree in question.
The tree’s top-level node, or root, appears in the
left pane.  Expand and contract nodes to display
the part of the tree you want to edit.

1. Enter information on the tree in the Find Trees
window, and click Find.
For example, enter %Payables% in the Prompt field
to find the Oracle Payables tree.

2. Double-click the line in the Trees tab of the main
Help Builder window that most closely
corresponds to the tree in question.
The tree’s top-level node, or root, appears in the
left pane.  Expand and contract nodes to display
the part of the tree you want to edit.
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Adding New Help Files to a TreeAdding New Help Files to a Tree

1. After opening the tree for editing, click Find
Documents on the toolbar.

2. Enter information on the files you want to add,
select Exclude documents already on a tree, and
click Find.
Files corresponding to the information you enter
appear on the Documents tab of the main Help
Builder window.

3. Drag files from the Documents tab and drop them
on the tree.

1. After opening the tree for editing, click Find
Documents on the toolbar.

2. Enter information on the files you want to add,
select Exclude documents already on a tree, and
click Find.
Files corresponding to the information you enter
appear on the Documents tab of the main Help
Builder window.

3. Drag files from the Documents tab and drop them
on the tree.

Note:
Files containing named anchors appear multiple times: once with the filename, and
once with each anchorname listed as the Target. Be sure to choose the anchorname that
corresponds to the topic you want to add.
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Adding New Nodes to a TreeAdding New Nodes to a Tree

1. After opening the tree for editing, select the node
above the place where you want to add a new
node.

2. Click New Node on the toolbar.
3. Enter information for the new node in the

Properties Pane.  Be sure to select Node from the
Type list of values.

4. Click Apply. 
5. To add a document to your new node, drag and

drop it directly on top of the node.

1. After opening the tree for editing, select the node
above the place where you want to add a new
node.

2. Click New Node on the toolbar.
3. Enter information for the new node in the

Properties Pane.  Be sure to select Node from the
Type list of values.

4. Click Apply. 
5. To add a document to your new node, drag and

drop it directly on top of the node.
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For Further InformationFor Further Information

For field reference definitions and information on
these topics:
• Copy nodes from one tree to another
• Change the organization of a tree
• Create a new navigation tree

See
(Help) Oracle Applications System Administration >
Customizing Help > …Navigation Trees 

For field reference definitions and information on
these topics:
• Copy nodes from one tree to another
• Change the organization of a tree
• Create a new navigation tree

See
(Help) Oracle Applications System Administration >
Customizing Help > …Navigation Trees 
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SummarySummary

You should now be able to:
• Download and upload help files
• Use Oracle Applications special syntax to link help

files
• Use the Help Builder to customize Help Navigation

Trees

You should now be able to:
• Download and upload help files
• Use Oracle Applications special syntax to link help

files
• Use the Help Builder to customize Help Navigation

Trees
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Using the Navigation Tree ExampleUsing the Navigation Tree Example

• Opening the Navigation Tree for editing
• Adding a new node to the tree
• Adding a new document to the tree

• Opening the Navigation Tree for editing
• Adding a new node to the tree
• Adding a new document to the tree

Using the Navigation Tree Example
This example demonstrates how you would open the Navigation Tree for editing and
add a new node and documents to the tree.  This example will show you how to access
the Oracle Applications AOL root, create a new node called “Flexfield Overviews” and
copy documents into this node.
Opening the Tree for Editing

1. Navigate to the Help Builder: OSSWA > System Administration > Help Builder.
2. In the Find Trees window, enter “Oracle Applications AOL” in the Prompt field

and click Find. The Oracle Applications AOL root will appear in the Trees tab in
the upper right pane of the Help Builder window.

3. Double-click “Oracle Applications AOL” on the Trees tab. This will display the
tree in the large left pane of the Help Builder window.

4. Click on the + to expand the tree. Open the Oracle Applications System
Administration node of the tree.
Notice that as you click on various nodes and documents on the tree the
Properties of the selected item are displayed in the Properties pane.

Add a Node to the Tree
1. Scroll down the tree until you the node called Applications DBA.  Select this title

by clicking on it once.
Note: Do not click on the +.  You do not want to expand this node, you just want
to select it in order to add a node beneath it.

2. Click the New Node icon on the toolbar to add a node beneath the selected node.
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3. In the Properties pane on the lower right, enter the name for the new node in the
Prompt field: “Flexfield Overviews.”

4. Click Apply.

Find and Add Documents to the Tree
1. Click the Find Documents icon on the toolbar to display the Find Documents

window. Enter “Overview” in the Title field and check the Exclude documents
already on a tree checkbox. Click Find.
The Documents tab in the upper right pane of the Help Builder window will
become enabled and display a list of documents which match your search
criteria.

2. Select the document with title “Overview of Flexfield Concepts.”
3. Drag and drop the document directly on top of you new Flexfield Overviews

node.  The document will immediately appear on the tree.  Repeat this step with
the following documents, dragging and dropping them beneath your first
document:

Overview of Shorthand Flexfield Entry
Overview of Flexfield Value Security

4. Save your work.
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System



Copyright © Oracle Corporation, 2000. All rights reserved.

Administering Folders
Chapter 11 - Page 3

Objectives

Copyright   Oracle Corporation,  2000. All rights reserved.
®

ObjectivesObjectives

After completing this lesson, you should be able to
do the following:
• Assign default folder definitions to a responsibility
• Assign default folder definitions to a user
• Assign ownership of a folder

After completing this lesson, you should be able to
do the following:
• Assign default folder definitions to a responsibility
• Assign default folder definitions to a user
• Assign ownership of a folder
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Folders: DefinitionFolders: Definition

A folder is a flexible entry and
display window in which you can
choose the fields you want to
see and where each appears in
the window.

A folder is a flexible entry and
display window in which you can
choose the fields you want to
see and where each appears in
the window.
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• Assigning default folder
definitions
– Responsibility
– Specific user

• Assigning ownership of a folder
• Deleting a folder

• Assigning default folder
definitions
– Responsibility
– Specific user

• Assigning ownership of a folder
• Deleting a folder
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Assigning a Default Folder to a
Responsibility

Assigning a Default Folder to a
Responsibility

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select “Default folder assignments by
responsibility” and select a responsibility from
the list of values. Click Find.

3. In the Folder field use the list of values to enter
the name of the default folder you wish to assign
to the responsibility.
You can also enter the Folder Set name first to
limit the Folder list of values to those in that set.

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select “Default folder assignments by
responsibility” and select a responsibility from
the list of values. Click Find.

3. In the Folder field use the list of values to enter
the name of the default folder you wish to assign
to the responsibility.
You can also enter the Folder Set name first to
limit the Folder list of values to those in that set.

Assign a Default Folder to a Responsibility
Note: You must create default folders before you can perform the following functions.
For information on creating default folders see
(Help) Oracle Applications User’s Guide > Folders >
Customizing the Presentation of Data in a Folder.
Note: After you save a default folder definition for a folder set, that folder set no longer
appears in the list of values.
Form Fields
Folder Set: Every folder set is associated with a particular folder block, and a user or
responsibility can have one default folder within each folder set. The folder set name
generally describes the records shown in the block; some blocks may have multiple sets
of folders associated with them.
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Assigning a Default Folder to a UserAssigning a Default Folder to a User

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select “Default folder assignments by user” and
select a user from the list of values. Click Find.

3. In the Folder field select the default folder you
wish to assign to the user from the list of values.
You can also enter the Folder Set name first to
limit the Folder list of values to those in that set.

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select “Default folder assignments by user” and
select a user from the list of values. Click Find.

3. In the Folder field select the default folder you
wish to assign to the user from the list of values.
You can also enter the Folder Set name first to
limit the Folder list of values to those in that set.

Assign a Default Folder to a User
Note: After you save a default folder definition for a folder set, that folder set no longer
appears in the list of values.
Form Fields
Source Type: Enter either User or Responsibility. Records entered in this window use
the source type of User. If one of the current user’s responsibilities has default folders
defined, the default folders are listed with a source type of Responsibility.
User defaults override Responsibility defaults. You cannot delete Responsibility default
folders in this window.
Responsibility: The Responsibility that uses this default folder definition.
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Assigning Ownership of a FolderAssigning Ownership of a Folder

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select the Folders option and choose either a
Folder or a Folder Set from the list of values.
Click Find.

3. Select the folder that requires ownership.
4. Click the Change Owner 1 button to display the

Change Owner window or enter the new owner in
the Owner field.

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select the Folders option and choose either a
Folder or a Folder Set from the list of values.
Click Find.

3. Select the folder that requires ownership.
4. Click the Change Owner 1 button to display the

Change Owner window or enter the new owner in
the Owner field.

Form Fields
Public: This check box governs the availability of the folder to all users.
Anyone’s Default: Indicates whether this folder definition is used as a default by a user
or a responsibility. If it is a default definition, use Default Assignments to view the
users and responsibilities for which it is the default folder definition.
Default Assignments: The users and responsibilities that use this folder definition as a
default.
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Deleting a Folder DefinitionDeleting a Folder Definition

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select Folders from the Find Folders window to
view general information about folders.

3. Select the folder(s) to delete.
4. From the Edit menu choose Delete.

Deleting folders deletes the folder definition
along with any user and responsibility default
assignments for the folder.

1. Navigate to the Administer Folders window:
(N) Application > Administer Folders

2. Select Folders from the Find Folders window to
view general information about folders.

3. Select the folder(s) to delete.
4. From the Edit menu choose Delete.

Deleting folders deletes the folder definition
along with any user and responsibility default
assignments for the folder.
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SummarySummary

You should now be able to do the following:
• Assign default folder definitions to a responsibility
• Assign default folder definitions to a user
• Assign ownership of a folder

You should now be able to do the following:
• Assign default folder definitions to a responsibility
• Assign default folder definitions to a user
• Assign ownership of a folder
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Managing Document Sequences
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Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button

(Help) = Oracle Applications Help System
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After completing this lesson, you should be able to
do the following:
• Define a document sequence
• Define a document category
• Select a specific document for sequencing
• Assign a sequence to a document
• Set the profile option : Sequential Numbering

After completing this lesson, you should be able to
do the following:
• Define a document sequence
• Define a document category
• Select a specific document for sequencing
• Assign a sequence to a document
• Set the profile option : Sequential Numbering

Lesson Aim
A document sequence is an internally managed log of transactions against a
particular table. Sequences enable complete auditing of all transactions, whether
successful or not. This lesson covers creating and implementing document
sequences.
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(101)(101) (102)(102) (103)(103)PaymentsPayments

(5001)(5001) (5002)(5002) (5003)(5003)InvoicesInvoices

Why Use Document Sequences?
Transactions Create Documents

• Whenever you enter a transaction, you create a document. For example,
when you enter a payment, you create a payment document. Or when you
enter an invoice, you create an invoice document.

• You can assign unique numbers to the documents that you create by using
document sequences.

Document Sequences Provide Completeness
• Completeness is proof that every document created by a user’s transaction

can be accounted for.
• By assigning unique numbers to documents, you can use document

sequences to account for all transactions, even those that fail.
Sequences, Categories, and Assignments

• Specify sequence information to determine how documents are numbered.
• Define document categories to group documents together.
• Associate a sequence with a document category to determine which

documents the sequence will number.
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• What should the sequence name be?
• How long should the sequence be in effect?
• How should the sequence numbers be entered?
• What should the beginning number be?

• What should the sequence name be?
• How long should the sequence be in effect?
• How should the sequence numbers be entered?
• What should the beginning number be?

Using Manual or Automatic Sequence Numbering
Certain information must be specified when a user creates a document
sequence. This includes the document name, its effective dates, and the type of
numbering used. The numbers associated with the documents can be entered
manually or generated automatically.
Manual Numbering of Documents

• User assigns a unique number to each document before it is generated.
• Numerical ordering and completeness are not enforced.
• Users may skip or omit numbers when entering the sequence value.

Automatic Numbering of Documents
• Automatic numbering sequentially assigns a unique number to each

document as it is generated.
• With automatic numbering, documents are numbered in order by date and

time of creation.
• Numbers are in sequential order with no gaps or omissions.
• The user specifies the initial value for the sequence.
• A message can be sent to the user whenever a sequence number is

assigned.
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Use the Document Sequences window to define a
new sequence:

(N) Application > Document > Define

• Define when a sequence is valid.  Leave the
Effective To field blank to enable a sequence
indefinitely.

• Use the Access region to specify the Oracle IDs
that use this sequence to number documents.

• Specify multiple Oracle IDs when multiple
installations of an application occur.

For further information about this window, see
(Help) Oracle Applications System Administration > Document
Sequences > Document Sequences Window

Use the Document Sequences window to define a
new sequence:

(N) Application > Document > Define

• Define when a sequence is valid.  Leave the
Effective To field blank to enable a sequence
indefinitely.

• Use the Access region to specify the Oracle IDs
that use this sequence to number documents.

• Specify multiple Oracle IDs when multiple
installations of an application occur.

For further information about this window, see
(Help) Oracle Applications System Administration > Document
Sequences > Document Sequences Window
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Interest payment

Expense 
reimbursement

Standard

Accounts
payable

Specifying Document Category
Information

Specifying Document Category
Information

Which tables should have their transactions
documented?
Should transactions against the same table be
broken down into logical subsets?

Which tables should have their transactions
documented?
Should transactions against the same table be
broken down into logical subsets?

Specifying Document Category Information
Sequences track the transactions against a particular application table. The
target table is identified by a document category. In some cases, transactions
against a table may need to be classified into subgroups according to some
criterion to obtain important information. For example, transactions against the
Accounts Payable table may need to be divided according to what type of
payment each transaction concerned.
Use categories to divide your documents into logical groups. For example,
accounts payable invoices can be divided into the following types:

• Standard invoices
• Expense report invoices
• Prepayment invoices
• Interest invoices
• Credit memo invoices
• Debit memo invoices
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A category identifies a database table where
documents can be numbered by an assigned
sequence.
To define a document category:

A category identifies a database table where
documents can be numbered by an assigned
sequence.
To define a document category:

1. Navigate to the Document Categories window:
(N) Application > Document > Categories

2. Select an application and one of its tables.
3. Assign the category a code and a name.

1. Navigate to the Document Categories window:
(N) Application > Document > Categories

2. Select an application and one of its tables.
3. Assign the category a code and a name.

Category Code and Name
• The combination of code and name must be unique within an application.
• Code must be unique. Name does not have to be unique.
• After a category is defined, you cannot change the choice of table.

For a complete explanation of the fields in the Document Categories window,
see
(Help) Applied Technology > Oracle Applications System Administration >
Document Sequences > Document Categories Window.
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Use the Sequence Assignments window to associate
a category with its sequence.
To assign a sequence:

Use the Sequence Assignments window to associate
a category with its sequence.
To assign a sequence:

1. Navigate to the Sequence Assignments window:
(N) Application > Document > Assign

2. Identify the applications and the category.
3. Enter a starting date and specify which

sequence applies to this category.

1. Navigate to the Sequence Assignments window:
(N) Application > Document > Assign

2. Identify the applications and the category.
3. Enter a starting date and specify which

sequence applies to this category.

For a complete explanation of the fields in the Document Categories window,
see
(Help) Applied Technology > Oracle Applications System Administration >
Document Sequences > Sequence Assignments Window.
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After the document sequence has been defined, the
category has been associated with a table, and the
sequence has been assigned to the category, you
can identify the document sequence to be used with
a particular business transaction when you are
creating the transaction.

After the document sequence has been defined, the
category has been associated with a table, and the
sequence has been assigned to the category, you
can identify the document sequence to be used with
a particular business transaction when you are
creating the transaction.

Example:
(N) Invoices > Standard > Enter

Example:
(N) Invoices > Standard > Enter
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You should now be able to do the following:
• Define a document sequence
• Create a document category
• Assign a document sequence to a category

You should now be able to do the following:
• Define a document sequence
• Create a document category
• Assign a document sequence to a category

Summary
Document sequences can be used to track all transactions against a table
regardless of transaction completion. These sequences can provide an audit trail
of transactions against a table. A particular table can have multiple categories
defined to it. In this way, different types of transactions can all be tracked.
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Scenario
Some discrepancies have been noticed recently
during invoice processing, and the department head
has decided to start keeping an audit of transactions
against the AP_INVOICES_ALL table.
To accomplish the necessary tracking of invoices,
you must create a document sequence and a
document category, and assign the document to the
table.

Scenario
Some discrepancies have been noticed recently
during invoice processing, and the department head
has decided to start keeping an audit of transactions
against the AP_INVOICES_ALL table.
To accomplish the necessary tracking of invoices,
you must create a document sequence and a
document category, and assign the document to the
table.

Create Your Document Sequence
Your first task is to create a sequence to generate the numbers.  To do this, you
would navigate to the Define Document window: (N) Application > Document
> Define and enter data similar to the following:

Name: My_AP_Invoices_Sequence
Application: Application Object Library
From: Today’s Date
To: Ending Date or leave blank
Type: Automatic
Message: enabled
Initial Value: 1

Create Your Document Category
After creating your sequence, you would create a document category and
associate it with the table whose transactions need to be accounted for.  To do
this, you would navigate to the Define Categories window: (N) Application >
Document > Categories and enter data similar to the following:

Application: Oracle Payables
Code: OPS01
Name: My_AP_Invoices_Category
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Description: Payables Invoice Category
Table Name: AP_INVOICES_ALL

Assign Your Sequence and Category
Your last task is to connect your sequence to your category.  To do this, you
would navigate to the Document Assign window: (N) Application > Document
> Assign and enter data similar to the following:

Application: Oracle Payables
Category: My_AP_Invoices_Category
Set of Books: U.S. Operations
Method: Manual
Start Date: Today’s Date
End Date: Ending date or leave blank
Sequence: My_AP_Invoices_Sequence
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